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Abstract 

DNA can function as a significant part of evidence in forensic investigation, because it can link 

a potential perpetrator to a crime. Even by skin contact, micro-traces of DNA-containing material 

can be transferred. This type of DNA is called ‘trace DNA’. When DNA is collected from an 
evidentiary item for forensic purposes, the goal is to collect as much as possible of the targeted 

DNA and as least as possible of other traces. The focus of this research is the collection of trace 
DNA from textiles. In the Netherlands Forensic Institute (NFI) this is mostly done by tape-lifting: 

using double-sided tape stuck to a stub, which is called ‘stubbing’. This method is used for about 

10 years now at the NFI. However, the evolution of stubbing for DNA collection has mainly been 
empirically driven and no studies are done to improve its technique, even though this would be 

very useful when miniscule amounts of DNA are searched. The stubbing force (the normal force 
applied on the stub while stubbing) is assumed to influence the trace collection efficiency when 

stubbing, because a higher stubbing force results in a larger actual contact area between the 
adhesive tape and the textile, by which traces on the textile can adhere to the tape. Though, 

the stubbing force is manually applied in the current stubbing procedure by which it cannot be 

accurately controlled. Thereby, this possibly leads to a difference in the quality of resulting 
samples among different forensic investigators.  

This research is focussed on how the stubbing force is related to the efficiency of the 
collection of micro-traces, and on how the collection efficiency differs for traces from different 

depths in the substrate structure. This latter issue is questioned, because if trace DNA from 

multiple DNA sources are present on an evidentiary item, which is often true, it is assumed that 
DNA-containing material of the last handler is present in more superficial layers of the substrate. 

In that case, it would be very useful to know how traces can be collected selectively from specific 
depths of the substrate to obtain samples with a higher ratio between the targeted DNA and 

other traces.  
 In this research, microspheres were used as representation of trace DNA. These spheres 

are sized in the same order of magnitude as skin cells (25 μm), which are a possible component 

in trace DNA.  Microparticles were applied to the substrates in a suspension of ethanol, to get a 
uniform distribution over different samples. Experiments were performed on multiple textile 

substrates: flat spools wrapped by three different types of polyester threads. Traces were 
collected by stubbing while using 5 different stubbing forces. The stub tapes, as well as the 

substrates (before and after sampling) were analysed by using the microscope. In MATLAB a 

script was designed to automatically count these particles using image recognition routines. 
Results gave insight in how stubbing force increased for the used materials. To define 

the trace collection efficiency from specific depths in the substrate structure, the designed 
method was too inaccurate. Though, the measured impression of the used textiles indicated 

that when stubbing with 1 N, the substrates were almost impressed to its maximum impression. 

This indicates that when stubbing with a stubbing force of 1 N particles are potentially not only 
collected from the most superficial layer in the substrates but also from deeper layers. 

Recommendations for future research are given in the discussion.  
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Nomenclature  

Substrate Physical surface (for example of an evidentiary item) on which a trace can be 
present 

Actual contact area Real contact area between two surfaces, also considering the surface roughness 
on microscopic scale 

Apparent contact 
area 

Apparent contact area on macroscopic scale (contact area that would exist if 
the contacting surfaces would be perfectly flat and perfectly aligned) 

  

Stub Forensic tool that is used to collect forensic traces: aluminium pin with a piece 
of double-sided adhesive tape on it, placed in a holder to handle it, and covered 
by a vial to avoid contamination 

Stubbing Tape-lifting method for which a stub with double sided adhesive tape is used 

Stubbing force Contact force between the stub and the substrate during tape application. If a 
substrate was sampled with a stubbing force of x N, this indicates the maximum 
normal force that was applied on the stub during this contact. 

  

Fibre Thinnest filament of a thread, for example from cotton or polyester 

Yarn  Fibres loosely twisted together 

Thread Two or more yarns twisted 
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1. 
 Introduction to stubbing and the influence 

of stubbing force 

 Background – The importance of trace DNA and its collection 
method 

Human witnesses are often lacking at a crime scene, therefore physical evidence plays an 

important role in forensic investigation. DNA-containing material is important physical evidence, 
because it can be used for the identification of people that were in some way involved in the 

crime scene. DNA can be transferred from the human body to the environment in many ways. 

Even by skin contact, micro-traces of DNA-containing material can be transferred. This type of 
DNA is called ‘trace DNA’. Trace DNA can be transferred via direct contact, for example by 

grabbing, touching, or wearing items, but even further by indirect body contact.  
Imagine the following case: a victim was brutally murdered by an unidentified person. 

His jacket is torn, probably by a serious fight. Therefore, it is very likely that trace DNA of the 

killer is present on this jacket, even though these traces are not visible with the naked eye. In 
this example, it would be really valuable to find trace DNA on the jacket, for it may provide a 

possible link between the murder case and one of the suspects. For an optimal result, it is crucial 
to collect as much as possible DNA of the killer and as little as possible other material that may 

contaminate the sample. In that way the chance is at its highest that the right person is coupled 

to the DNA profile resulting from the analysis of the DNA sample. To achieve this, it is of 
particular interest to select the right collection method and to use this method optimally. 

 

 

Figure 1 Stub that is used for DNA collection, with a double-sided adhesive tape attached                                
to its pin (Ø 12.7 mm). 

 

Different methods exist for the collection of trace DNA. For traces on evidentiary items of textile, 

such as the jacket in the example above, forensic investigators at the Netherlands Forensic 
Institute (NFI) use adhesive tape to lift DNA traces from textile. The adhesive tape is double 

sided and is stuck to a so called ‘stub’, see Figure 1. This tape-lifting method, more specifically 
called ‘stubbing’, is mainly used for the collection trace DNA from cotton/polyester or cotton1. It 

is a well working method that has been used about 10 years at the NFI for the collection of 

trace DNA. Yet, only a few studies were found that investigated this stubbing method. In a prior 

                                                
1 Personal interviews, 30/09/2015 [1].   
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literature study [1], one study was found that investigated what tape was most suitable to use 

[2] and one study that investigated the relation between the number of tape-lifts and the 
amount of collected DNA [3].  

 

 Problem statement and research goals – The influence of 
stubbing force 

To optimize the chance that the right person is coupled to a crime by using a DNA sample, the 

collected DNA sample should contain as much as possible of the targeted DNA and as least as 

possible ‘noise’, which can be DNA from another person, or material that inhibits the further 
processing of the DNA. If no noise is present on the sampled evidentiary item, the only focus 

during stubbing is to collect as much target DNA as possible. However, in practice this would 
rarely happen, because when an evidentiary item is previously touched by other people, their 

DNA can still be present on the item. 
To get the ratio between targeted DNA and noise as high as possible, it has to be known 

where these different micro-traces are expected in the substrate (the surface on which the trace 

is present). It is assumed by forensic experts that the distribution of DNA traces from different 
DNA sources is mostly layered. DNA-containing material of the last occurred touch event is 

assumed to be present more superficially than earlier applied traces such as wearer’s DNA (DNA 
transferred by wearing the evidentiary garment)2,3. This assumption is plausible, especially when 

the trace deposited by the last touch event is dry and does not easily penetrate through the 

substrate. However, no studies were found that support this hypothesis. So, there are multiple 
trace distributions possible, schematically represented in Figure 2. Note that these are simplified 

representations and that layered traces might not be strictly layered. 
 

 

 
Figure 2 Targeted DNA and noise can be positioned on a substrate in various compositions, which are 
represented in this table. Note that on rough substrates the different traces can also be present in the 

same height of the structure (deep or superficial). 

If the targeted DNA and the noise are fully mixed (and these traces have the same adhesive 
properties), it is probably impossible to influence the ratio between targeted DNA and noise with 

adaptions to the stubbing technique. In this case, it would mostly be favourable to collect as 

much as possible of the mixed traces. Therefore, it will be investigated in this research what 
stubbing force should be used to collect as much as possible micro-traces from a textile 

substrate.  
When the targeted DNA and the noise are present in different depths of the substrate 

structure, the used stubbing technique can possibly influence the ratio between these traces in 

the resulting sample. To do so, a technique should be found with which it is possible to 
selectively collect material from certain depths of the substrate. In prior literature study [1], it 

                                                
2 Kramer, Gerco. Personal interview. 30/09/2015 [1].    
3 Verhoeff, Martine. Personal interview. 30/09/2015 [1].    
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turned out that this is most likely possible by adapting the force that is used during stubbing. 

The stubbing force influences the impression of the substrate and thereby contact between the 
tape and the trace present on the substrate is influenced.  

Nowadays, the stubbing force is manually applied. There seems to be high variations in 
the used stubbing force among forensic experts and among repeating trials of individual experts. 

This was tested by Wendt [4], who measured the vertical force while forensic investigators 

stubbed on different textiles that were placed over mock-up skin. Furthermore, no experiments 
were found that studied the influence of stubbing force on micro-trace collection efficiency. 

Nevertheless, forensic investigators use a higher stubbing force to collect deeper traces4, even 
though there is no evidence to support this is true. Moreover, it has never been defined what a 

‘high’ or ‘low’ stubbing force is. Therefore, another goal of this research is to investigate the 
relation between the used stubbing force during stubbing and the collection efficiency of micro-

traces from different depths in the substrate structure. 

 
To improve the ratio between targeted DNA and noise in samples, two DNA transfer steps need 

to be considered. Firstly, it should be investigated how traces are distributed over the substrate 
structure after various scenarios of DNA deposition by humans and ageing of the traces. 

Secondly, it should be examined if it is possible to selectively collect traces from selective layers 

in the substrate structure by stubbing. Together, these insights could give more information 
about the stubbing technique that should be used for selective collection of the targeted trace. 

This research is only focussed on the second transfer step, see Figure 3. Therefore 
controlled trace deposition is used, so purely the influence of the stubbing technique on the 

trace collection efficiency can be measured without unintendedly measuring influences of 
variations in trace deposition on the experiment results.  

Other microparticles than trace DNA were chosen as deposition material (see paragraph 

2.3), because quantifying amounts of DNA was not feasible in this project. Gaining knowledge 
about the influence of stubbing force on the collection efficiency of these microparticles will be 

the first step to gain more insight in the relation between stubbing force and the efficiency of 
the collection of trace DNA through stubbing.  

 

 
 

 

Figure 3 The ratio between the targeted DNA and noise in a sample is influenced by the deposition of a 
trace by the DNA source (a human) and ageing of this trace, and by how this trace is collected. This 

research is focused only on this second transfer step (see dashed frame). 

 

 Research questions 

Two research questions were formulated: 
 

Question 1 
What is the influence of the stubbing force on the efficiency of the collection of microparticles 

from a substrate? And how does this effect differ for different textiles? 

 
Question 2 

How does the particle collection efficiency of stubbing differ for microparticles at different depths 
in the substrate structure? 

                                                
4 Verhoeff, Martine. Personal interview. 30/09/2015 [1].   
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 Hypotheses  

Microparticles can be tape-lifted from a textile substrate due to adhesive bonding between the 

adhesive tape and the microparticles. Adhesive bonding is determined by two aspects: bond 
strength and bond formation [5]. Because of the low weight of the microparticles, it was 

hypothesised that only low bond strength is needed to result in adhesive bonding by which the 
microparticles can be tape-lifted from the textile. Therefore, the adhesive bonding between the 

tape and the microparticles was thought to be mainly dependent on bond formation, which is 

possible when contact is made between the tape and the particles. In this hypothesis, 
electrostatic attraction between the tape and the microspheres over a distance is disregarded.  

Contact between the tape and a microparticle will be formed under approximately the 
same conditions as contact between the tape and the textile that is close adjacent to that 

particle. Therefore, the number of collected microparticles during tape-lifting from textile is 
hypothesised to be approximately equal to the actual contact area between the tape and the 
textile 𝐴𝑎𝑐𝑡𝑢𝑎𝑙 𝑐𝑜𝑛𝑡𝑎𝑐𝑡    [𝑚𝑚2] times the particle coverage on the actual contact area 

 𝜌𝑝𝑎𝑟𝑡𝑖𝑐𝑙𝑒 𝑐𝑜𝑣𝑒𝑟𝑎𝑔𝑒  [#/𝑚𝑚2] , see equation 1.1. The particle coverage depends on how the 

microparticles are distributed over the textile. 
 

𝑛𝑐𝑜𝑙𝑙𝑒𝑐𝑡𝑒𝑑 𝑚𝑖𝑐𝑟𝑜𝑝𝑎𝑟𝑡𝑖𝑐𝑙𝑒𝑠 [#]

≈  𝐴𝑎𝑐𝑡𝑢𝑎𝑙 𝑐𝑜𝑛𝑡𝑎𝑐𝑡[𝑚𝑚2]  ⋅  𝜌𝑝𝑎𝑟𝑡𝑖𝑐𝑙𝑒 𝑐𝑜𝑣𝑒𝑟𝑎𝑔𝑒  [#/𝑚𝑚2]   

Eq. 1.1 

 

This theory leads to the hypotheses specific for research question 1 and 2:  
 

Hypothesis to research question 1: 

Under a higher stubbing force, textile fibres are compressed more, by which the actual contact 
area between the tape and the textile increases. Therefore, it was hypothesised that stubbing 

an equal sample with a higher stubbing force results in a larger amount of collected 
microspheres. This statement is true until the actual contact area between the tape and the 

textile is as large as possible, and it is expected to be only valid if the surface that is not covered 
by the tape yet does contain microparticles.  

 

Hypotheses to research question 2: 

The efficiency of the collection of microparticles that are located deeper in the substrate 

structure is lower than for particles that are located more superficially when stubbing with the 
same stubbing force. This difference is larger when stubbing with lower stubbing forces. It is 

hypothesised that it is possible to solely collect particles that are superficially present in the 

substrate surface when stubbing with a low stubbing force by which only contact between the 
tape and the superficial area of the substrate is made. 

 
 

 Report outline 

In chapter 2 the materials and methods are discussed that were required to find an answer for 

the research questions. In chapter 3 the results of the experiments are displayed, which are 
discussed in chapter 4. Finally, chapter 5 provides a summarized conclusion of this research.  
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2. 
 Materials and methods 

 
Figure 4 Schematic experiment setup.  

 
Microparticles were deposited on three types of polyester substrates. The micro-traces were 

collected by stubs, using different stubbing forces. The stub-tape and the substrates were 

analysed using a microscope. The microparticles in the microscope images could automatically 
be counted in a MATLAB script based on image recognition routines. Thereby, the trace 

collection efficiencies could be calculated.  
To perform these experiments, multiple materials had to be selected, see Figure 4. In this 

figure, the paragraphs are indicated in which the mentioned materials are described. 

 

 Stubs  

The same aluminium stub-pins as those currently used at the NFI for DNA collection were used 

in these experiments, see Figure 5. The stub holders were not used, because it was more 
practical to directly clamp the stub-pins into the setup. Double sided adhesive tape (Scapa 4405, 

which is also used at the NFI) was stuck to the Ø12.65 mm surface of the stub-pin. The top 

surface beneath the transparent tape was painted black to improve the visibility of microparticles 
on the tape.  

 

a.) b.)  

Figure 5 a.) Aluminium stub-pin (dimensions in mm). b.) Picture of stub-pins with a black painted top 
surface and a round tape stuck to it. This is how the stubs were used in this research.  

 

F 
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For forensic investigation purposes, the adhesive tape that is stuck on the stub-pin is usually cut 

in squares, for which the exact dimensions of the tape are not really important. The corners of 
the tape go beyond the edges of the stub-pin, and thereby these parts of the tape are not 

supported by the pin during stubbing. These loose corners are practical for detaching the tape 
from the pin after DNA collection by using tweezers. However, for the current research purposes 

it was important that all used tapes were equally sized and that the whole tape was supported 

by the stub-pin. Therefore, the adhesive tape was punched in 10 mm diameter round pieces. 
Pieces of double sided tape were placed on a flat wooden plate with the silicone paper cover at 

the bottom side. Circles were punched out with an arc punch, using a steel hammer. Every 
round tape was lifted out of the arc punch using tweezers and placed with the uncovered side 

of the tape on a clean stub-pin. Finally, the tape was pressed gently to the stub with the rounded 
side of the tweezers and pressed more firmly to the stub by placing a mass on the tape (still 

covered by silicone paper). This silicone paper cover was removed at the moment that the tape 

was used for experiments. The stubs were placed in a holder, see Figure 50 in Appendix B, and 
stored in a closed box to protect it from contamination. The tape cutting procedure is described 

in more detail in Appendix A. 
 

2.1.1 Adhesive performance of tape after UV irradiation 

In this research, the same stub-pin and adhesive tape were used as currently used at the NFI, 
so that results of this research are applicable in the current procedures. However, in the current 

stub preparation procedure, the adhesive tape is irradiated with UV light. This is done to avoid 
the presence of DNA of an innocent DNA source on the tape. The adhesive tape is not 

recommended for direct exposure to sunlight or UV light [6]. However, no studies were found 
that studied the influence of this UV irradiation process on the adhesive performance of the stub 

tapes. Therefore, this effect had to be examined. If a noticeable effect was measured, it would 

have been necessary to apply UV irradiation in the stub preparation procedure for this research. 
This would ensure that tape would be used with similar adhesive properties as the tape that is 

currently used for forensic trace collection.  
 The influence of the UV irradiation process on the adhesive performance of the double 

sided adhesive tape was examined by comparing the adhesive force between the tape and a 

glass slide for not UV irradiated tape and for tape that was UV irradiated. Adhesive tape was cut 
in 10 mm diameter circles, like it was done for the main experiments (described in Appendix A). 

12 of the cut tapes were not UV irradiated. 12 tapes were UV irradiated according to the standard 
procedures of the NFI: both sides of the tape were exposed to UV light (2 lamps: Philips TUV 

TL-D 15W T8 UV-C 437 nm) in a fume cabinet for 1 hour, see Figure 6. The first side was UV 

irradiated before the tapes were cut. Therefore, a strip of adhesive tape was rolled out with its 
silicon protection paper situated at the bottom side and fastened to a clean surface. The seconds 

side of the tape was UV irradiated after the tapes were cut and stuck to the stubs and after the 
silicon protection paper was removed from the tape. 12 other tapes were UV irradiated according 

to a similar procedure, but instead of the UV light source of the NFI, a new setup was used that 
was developed at the TU Delft by Windemeijer et al. [7], see Figure 7. This setup was designed 

to enable making the adhesive tape DNA free by exposing both sides of it to UV light for only 5 

minutes instead of 1 hour. The minimum UV dose measured in the fume hood at the NFI was 
used as minimum required UV dose in the new setup, which is 20.000 J/m2 in 1 hour [7]. The 

setup consists of two Philips PL-L 55 W UV lamps with a length of 52 cm, and the tape could be 
placed with a distance of 7.5 cm under the lamps. During the UV irradiation, the environment 

was properly ventilated, for ozone might have been released during this procedure [7]. 
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Figure 6 Fume cabinet with a UV light source. 
In the fume hood, a holder is placed that 

contains stubs with tape. 

Figure 7 UV light source prototype developed at 
the TU Delft by Windemeijer et al. [7].

The maximum adhesive force between the tape and standard microscope glass slides 

(76x25mm) was measured after stubbing with 1, 3 and 9 Newton (3 trials for 1 and 3 N, and 6 
trials for 9 N stubbing force). The force on the stub was applied as described in subparagraph 

2.5.1. The glass slide was clamped in the substrate clamp, see Figure 18, and cleaned with a 
cleanroom wipe and ethanol before every trial.  

 The results of this experiment are displayed in paragraph 3.1. Based on these results it 
was chosen not to apply UV irradiation to the tape in further experiments of this research. 

 

 Substrate material 

The following four options were considered as substrate materials to use in this research:  

1. Fabrics 

Woven fabrics bought off-the-shelf. 

2. Spools of threads 

Textile threads wound around a flat metal spool. 

3. Modified plastics 

Plastic surfaces with a variation in hardness and roughness. The variation in hardness 

could be achieved by using different plastics. Macro roughness could be achieved by 

CNC face milling with an angular milling cutter. Different milling depths can be used. 

Micro roughness on the plastic surface could be achieved by using sand paper or sand 

blasting (the second option is required when macro roughness is already applied to the 

material).  

4. Panty hoses 

Panty hoses made from a mixture of polyamide (a synthetic fibre) and elastane, see 

Appendix C. 

 

To choose the most suitable substrate material for these experiments, the optional substrate 
materials were evaluated based on several requirements. Firstly, to contribute to the research 

questions, which are specifically focussed on stubbing from textile, the substrate material should 
not deviate too much from textile. Therefore modified plastic was not a suitable option. 
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Secondly, systematic variation between different versions of the substrate should be possible, 

so the influence of these variations on the relation between stubbing force and trace collection 
efficiency could be studied. Woven fabrics and panty hoses cannot vary systematically because 

more factors would vary simultaneously: the thread type, weaving type, and for panty hoses 
also the ratio between the different materials of which these consisted (polyamide and elastane), 

see Appendix C. Finally, the substrate choice was determined by practical considerations: 

manufacturability and availability in future research. Based on these last requirements spools 
with threads scored the best. The considerations above are discussed in more detail in Table 5 

in Appendix D. This table shows some other considerations on which the substrate choice was 
based. In conclusion, spools with threads were regarded as the most suitable substrate material 

for these experiments.  
 

Three different threads were selected to wrap around the spools, see Figure 8. For a good 

visibility of the micro-traces on the substrate, the substrate colour was chosen to be black. More 
specifications are displayed in Table 1.  

 

 
Figure 8 Polyester substrates made of three different threads: sewing polyester, extra strong sewing 

polyester and crochet polyester. See Table 1 for the thread specifications. 

 
Table 1 Specifications of the used threads. 

Thread 
type 

Material Brand Colour Length Weight/ 
length 

No/tkt
** 

Crochet 100% 
polyester 

Amy, Zeeman textielSupers black 140 m 0.36 g/m - 

Sewing 100% 
polyester 

Sew-all thread, Güttermann, 
made in Germany 

black 200 m 0.03 g/m* 100* 

Sewing 100% 
polyester 

M782 Extra Strong, 
Güttermann, made in Germany 

black 100 m  0.075 
g/m* 

40* 

* From: www.guetermann.com 
** The ticket number is a measure for the thickness of a sewing thread. 

 

 
The spool base was produced from steel according to the dimensions in Figure 9. Firstly, a 

thread was knot through one of the holes. Then, the thread was manually wrapped around the 

spool base (around the long axis). Every winding had to be adjacent to the previous winding, in 
such a way that now ‘gaps’ were visible with the naked eye between neighbouring windings. 

Finally, the thread was knot through the second hole in the spool. 
 

http://www.guetermann.com/
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Figure 9 Dimensions of the base of the spools, made from steel with 3 mm thickness (dimensions in 

mm). 

 

Before use (or reuse) of a spool with fibres it was cleaned with water. To clean a spool, all its 

four long edges were kept under a warm, fast running water tap for about 10 seconds each 
side. The spool was moved back and forth during this to make sure the water flowed over the 

whole surface. After cleaning, the spool was dried by rolling it into a cleanroom wipe and 
compressing it firmly. Then the spool was dried in the air, under room temperature for at least 

12 hours, with all sides of the substrate free to dry.  
 The spools were labelled so these could be distinguished during the experiments. On 

each spool 5 sample circles were defined. These could be distinguished by a cover that contained 

circular gaps of 14 mm diameter, see Figure 10. This cover was placed on the spool after micro-
traces were deposited on the substrate (see paragraph 2.4). For a more detailed description of 

the preparation of the substrates, see Appendix E. 
 

 

 
Figure 10 Sample cover made from aluminium of 0.5 mm thickness (dimensions in mm). The covers 

were manufactured in a laser cutter. 

 
Standard microscope glass slides (76x25 mm) were used as fourth substrate type. The variation 

in height profile of the glass slides can be negligible. Therefore, this substrate was used as 

reference to indicate the collection efficiency when full contact between the tape and the 
substrate is approached. Note that even when sampling from glass, there is no completely full 

contact, because the tape does not have an entirely flat surface and microparticles can be 
overlapped, by which contact with other particles is impossible. 
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 Micro-traces 

In these experiments, a representing material for trace DNA was used, because using real trace 

DNA was impractical in terms of costs and time and because quantification of DNA is not very 
accurate. Furthermore, the content of trace DNA cannot be unambiguously determined. The 

content strongly varies per DNA source, preceding activities, etc. So, even if real DNA-containing 
material had been chosen as deposition material for these experiments, it could not be defined 

what this exactly should consist of: sweat, skin cells, saliva and/or other material. 

 Red fluorescent polystyrene microspheres (25 μm diameter, 12% Coefficient of 
Variation, Fluoro-MaxTM, Thermo scientific) were chosen to use as representing micro-traces in 

these experiments. These particles were chosen for several reasons. Firstly, the size of these 
particles is in the same order of magnitude as the size of skin cells, which have a diameter of 

about 30 μm [8] and which can be present in trace DNA. The microspheres have very little 
difference in size and shape, which is advantageous, because thereby no unintended effects of 

particle size on the collection efficiency could be measured. Secondly, these microspheres are 

visible very well under the microscope, even without a fluorescent light source. And finally, the 
material can remain in a suspension without dissolving, which is needed for the selected 

deposition method.  

 

 Sample preparation 

The microspheres were deposited on the substrates in a suspension of ethanol, see Figure 11. 

This liquid spreads out well over the textile, better than water, and so it results in a uniform 

distribution of the particles over the whole surface of the spools. 

 
Figure 11 Microspheres were deposited in a suspension of ethanol. Equally sized droplets were evenly 

distributed over the spool with threads. 

The concentration of the suspension was determined based on the demand that a circle of 10 

mm diameter (surface area of the tape) should contain about 1000 microspheres. It was chosen 
to deposit the suspension by 4 droplets of 0.025 mL ethanol per sample circle (20 droplets on 

each spool), so this would result in an even more homogeneous trace distribution than when 

using one droplet. This led to a desired concentration of microparticles (9.2E4 particles/mg [9]) 
in the suspension of 0.354 mg/mL, see calculations in Appendix F. An amount of microspheres 
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was weighed, enough to prepare all 60 textile samples (𝑚𝑚𝑖𝑐𝑟𝑜𝑠𝑝ℎ𝑒𝑟𝑒𝑠 > 60 ⋅ 3.54 ⋅ 10−2 𝑚𝑔), see 

Figure 12. The microspheres were put in a jar and then ethanol was added so the suspension 

reached its desired concentration. Before the suspension was applied to the substrates, the 

suspension jar was put in an ultrasonic bath for 2 minutes at room temperature to break 
agglomerates of spheres into seperated particles, see Figure 13. 

Then the suspension was deposited on the substrate using a pipette that could deposit 
0.025 mL droplets. The distance between droplets was controlled by pipetting through a self-

designed tool that contained holes at every 4 mm (20 holes in total), see Figure 14. After the 

deposition of every 5 droplets the suspension jar was shaken, because otherwise the 
microspheres would sink down, and the pipette was rinsed two times with clear ethanol, so that 

the concentration would not increase over time due to particles remaining in the pipette tip.  
When the deposition was finished, the substrates dried to the air for at least 24 hours 

before the samples were stubbed.  
 

 

                  

Figure 12 The microspheres were weighted at a 
digital mass weighing scale.  

 
 

Figure 13 Before the suspension was deposited 
on the substrates the suspension jar was put in 
an ultrasonic bath (VWR ultrasonic cleaner) for 

2 minutes at room temperature to break 
agglomerates of spheres. 

 

 
Figure 14 Technical drawing of the tool that was used to deposit droplets on the substrates (dimensions 
in mm). This tool contains 20 holes in which the pipette tip could be positioned to deposit a droplet of 

the suspension, see Figure 11. 
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 Applied stubbing forces 

The stubbing force is defined as the contact force between the tape and the sampled substrate 

during one tape application. If it is mentioned that a sample was stubbed with a stubbing force 
of for example 7 N, this means that the maximum stubbing force during the contact moment 

was 7 N. Note that it is basically the pressure between the tape and the sampled substrate that 
influences the collection efficiency. However, it is more practicable to control the stubbing force, 

because the pressure depends on the actual contact area over which the force is distributed, 

and the size of this area cannot exactly be determined. Moreover, the force is much easier to 
interpret when the experiments results are linked to the practice of stubbing.  

 

2.5.1 Method of force application 

An Instron tensile tester (model no.: 4505, serial no.: H2164) with a static load cell of +-100 N 
(Instron, serial no.: 65883) was used to accurately impose a normal force on the stub under a 

fixed speed of application on and separation from the substrate. 

To clamp the stub-pins directly to the load cell, a stub clamp was designed in which the 
stub-pins could be easily replaced, see Figure 15 and Figure 16. 

 

    

Figure 15 Stub clamp that was designed to connect the stub-pin with the load cell. 

 
Figure 16 Technical drawing of the stub clamp that was used to connect the stub-pin to the load cell of 

the tensile tester (dimensions in mm). 

clamp 

stub 
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To clamp the textile substrates tightly to the moving crosshead of the tensile tester, a substrate 

clamp was designed, see Figure 17 and Figure 18. In this clamp the substrates could be replaced 
and could be moved in the horizontal plane, so all 5 sample circles on one spool could be lined 

up with the stub. 
 

              

Figure 17 Substrate clamp to fix the substrate to the crosshead of the tensile tester.  A piece of masking 
tape with a reference mark was attached to the crosshead, so the sample areas on the substrate could 

easily be aligned with the centre of the stub. 

 

 
Figure 18 Technical drawing of the substrate clamp (dimensions in mm). It could be used to clamp a 

spool with fibres as in Figure 17, secured by two M8 bolts and fender washers, or to clamp a glass slide 
on the surface of 92.5x20 mm, secured by two M4 bolds and slides with rubber that press the glass to its 

support. 

 
At the start of the experiments, the load cell was calibrated in the Instron software (which had 

to be done without external load) and then the stub holder was attached to it. The substrate 

holder was attached to the crosshead, see Figure 17. The sample areas on the substrates were 
absolutely not touched (apart from the intended contact with the stub). 

 For every tape-lift, the following actions were performed. Firstly, the stub with tape (still 
covered by the siliconized paper cover) was fastened in the stub clamp by tighten the small bold 

Crosshead  

Substrate clamp 

Substrate 

Reference mark 
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when the stub-pin is placed as deep as possible in the clamp. The white reference mark on the 

stub was aligned to the reference mark on the stub holder, see Figure 15, to roughly determine 
the position of the tape relative to the sample circle. Secondly, the substrate was fastened in 

the clamp and one of the sample circles was positioned under the stub in a way that the stub 
could not make contact with the sample cover. When the setup was properly aligned, the tape 

cover was removed and the stub was positioned close to the substrate. Finally, it was needed 

to ‘zero’ the crosshead and to ‘balance’ the load cell in the software, so the vertical starting 
position of the stub with respect to the substrate was defined as 0 mm and the measured 

starting force as 0 N. 
During each tape-lift the same method of force application was used, see Figure 19. The stub 

approached the substrate with a speed of 0.02 mm/s until the maximum allowed stubbing force 
was reached. This speed was set low to avoid too much overshoot after the maximum allowed 

force was reached. Then, the contact was held for 0.5 s followed by separation with a speed of 

1 mm/s to a position 10 mm above the starting position. The used stubbing force, substrate 
name and stub name were noted and the stub was placed back in the stock box.  

 
 

 
Figure 19 Method of force application conducted by the tensile tester. 𝐹𝑚𝑎𝑥 was defined according to 

subparagraph 2.5.2. 

 
The data that was obtained by using the tensile tester can be considered precise enough for 

what it is used for. Every 0.002 seconds a sample was taken. With the approaching velocity of 
0.02 mm/s that was chosen, this resulted in resolution of 2.5E4 samples per millimetre 

displacement of the stub. This sample rate was maintained until the specified maximum force 
𝐹𝑚𝑎𝑥 was reached (defined in subparagraph 2.5.2). After this moment, the resolution decreased 

to 10 samples/mm. Considering the resolution, it is not likely that the resolution of the tensile 

tester was a limiting factor in the interpretation of the impression of the threads versus the 

stubbing force.  
 

2.5.2 Magnitude of stubbing forces  

Five different stubbing forces were selected in a way that the measured data for these forces 

properly describe the relation between stubbing force and micro-trace collection efficiency. It 
was hypothesised that the collection efficiency was proportional to the actual contact area 

between the tape and the substrate times the microparticle coverage on the actual contact area. 

Therefore, the stubbing forces were chosen in such a way that these measuring points together 
describe the trend of increasing contact area with increasing stubbing force. In this approach 

the particle distribution over the material was not taken into account yet.  
To determine the relation between the stubbing force and the actual contact area between 

the tape and the sampled substrate, a pre-test with the tensile tester was performed to 

determine the relation between the stubbing force and the impression of the textile. A simplified 
calculation was subsequently used to estimate the actual contact area between the tape and 

the substrate based on the measured impression of the substrate. 
 The relation between the stubbing force and the impression of the textiles was defined 

over a force range from 0 to 9 N. To do so, the tensile tester was used and the same method 
of force application was used as described above, see Figure 19. On all three substrate materials, 

3 trials were performed: in sample circles 1, 3 and 4 of the same spool of threads, see Figure 

20. The trials were performed in succession without replacing the stub and/or tape. Before the 

 

Ramp 1:  Extension:  -0.02 mm/s  
      Load:  [𝐹𝑚𝑎𝑥] N  

Hold 2:  Duration: 0.5 s  

Ramp 3: Extension: 1 mm/s  
Extension: 10 mm 
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used trials, an additional trial was performed of which the resulting data was rejected. This was 

done because replacing of the stub gave errors to the first measurement, probably because the 
stub had to settle in the stub holder.  

 The resulting data was processed as follows. The moment of first contact was defined 
as the moment on which the measured force surpassed the noise in this signal (𝐹 > 0.005 𝑁), 

see ‘read_data.m’ in Appendix J. Note that the measured impressions were influenced by the 

deformation of the system that supports the tape and the textile. So, to know the impression of 
just the fibres and the tape under a certain stubbing force, the measured impression was 

reduced by the deformation of an empty metal spool and a stub without tape that was measured. 
It was taken into account that the system’s deformation slightly differed between sample circles 

on the metal substrate base, see Figure 21. This was caused by the fact that the metal base 

was only supported at its ends (otherwise the impression of the textile threads at the bottom of 
the metal would be measured too). The measured absolute impressions of the textile threads 

and tape are represented in Figure 23. The F,d-plots of the individual trials can be found in 
Appendix H.  

The system’s deformation including the impression of the tape is shown in Figure 22. Here 
it can be seen that the measured deformation is much higher than for the same system without 

tape (Figure 21). This indicates that the measured absolute impressions, displayed in Figure 23, 

are indeed defined by the impression of the tape and the textile, and not only by the impression 
of the textile. It was checked if the measured deformation of the system, without tape and with 

tape, was influenced by the order of the measurements. It turned out that this had no effect. 
In Figure 22 the order of measurements is displayed. 

 

 

 

 

 
Figure 20 Sample circles at location 1, 3 and 4. 

 

1 

3 
4 
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Figure 21 Deformation of the steel spool, the 
stub without tape and mounting under an 

applied force. 

Figure 22 Deformation of the steel spool, the 
stub with tape (𝑡 = 0.1 𝑚𝑚 [6]) and mounting 

under an applied force.

 
 

 
Figure 23 Mean absolute impression of the textile substrates and the tape (with a thickness of 0.1 mm 

according to the product specifications [6]) while stubbing with a 12.65 mm diameter aluminum stub-pin. 
The deformation of the system, see Figure 21, was subtracted from the measured data (n=3 for each 

material). 

 
A simplified approximation was used to relate the impression d  of the textile substrates to the 

relative contact area between the tape and the substrates. The tape was approached as a rigid 

surface pressing in the thread which was approached as an elastic cylinder with a diameter 
equal to the measured thread thickness, see Figure 24. The thickness of the used polyester 

threads was measured under the microscope, see Appendix G. 
 

2th  
5th  
10th  
6th  
7th 
8th 
4th 
9th 
3th  
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Figure 24 Figure that explains the used contact theory, for which the tape was considered as a flat rigid 
surface (in blue) and the threads were considered as cylinders (in grey). The indention 𝑑 of one thread 

results in a contact area with contact radius 𝑎. 

       
The contact radius 𝑎 in Figure 24 was calculated according to the classical solution for non-

adhesive elastic contact between two cylinders with parallel axes [10]: 

 

𝑎 = √𝑅𝑑 Eq. 2.1 

 

Where R can be calculated by: 
1

𝑅
=  

1

𝑅𝑡𝑎𝑝𝑒

+
1

𝑅𝑡ℎ𝑟𝑒𝑎𝑑

 
Eq. 2.2 

The tape was approached as a flat rigid surface, 𝑅𝑡𝑎𝑝𝑒 =  ∞, and therefore 𝑅 = 𝑅𝑡ℎ𝑟𝑒𝑎𝑑.  

If fibres are adjacent to each other without free space in between, the contact radius that relates 
to the apparent contact area is 𝑅𝑡ℎ𝑟𝑒𝑎𝑑. Therefore, the relative contact area between the tape 

the thread can be calculated as: 

 

𝑅𝑒𝑙𝑎𝑡𝑖𝑣𝑒 𝑐𝑜𝑛𝑡𝑎𝑐𝑡 𝑎𝑟𝑒𝑎 =  
𝑎

𝑅𝑡ℎ𝑟𝑒𝑎𝑑

⋅ 100 % Eq. 2.3 

Together with the pre-test data, these calculations led to the relation between the relative 

contact area 
𝑎

𝑅
 and the stubbing force for all three different textiles, see Figure 25. In these 

calculations, the first contact between the tape and the top of the thread that was represented 

as a cylinder, was defined by the first moment of contact between the tape and the substrate 

measured by the tensile tester. However, as described above, this first moment of contact 
measured by the tensile tester was defined by contact with extruding fibres and irregularities in 

the substrate structure.  The moment of contact between the tape and the top of the threads 
(𝑑 = 0 𝑚𝑚 in the calculation) could not be defined more accurately based on the measured 

data. At this moment, an abrupt change in the stiffness (
Δ𝐹𝑠𝑡𝑢𝑏

Δ𝑑
) was expected. However, this 

could not be observed in the data. If the moment contact with the thread tops could have been 

defined more accurate, the plots of the relative contact area would shift downwards and the 

steepness at the beginning of the plot would reduce.  
Furthermore, for the calculation of the relative contact area it was assumed that the 

threads were so closely wound together that there was no distance between the threads, and 
therefore the radius that related to the apparent contact area was given by 𝑅𝑡ℎ𝑟𝑒𝑎𝑑. However, 

in practice there was some free space between the threads, so the ratio between the real contact 

area and the apparent contact area would be lower in practice.  
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Figure 25 Calculated relative contact area versus the stubbing force, based on data from the tensile 
tester and simplified calculations. The relative contact area is a measure for the actual contact area 

relative to the apparent contact area between the tape and the textile. The dots represent the chosen 
stubbing forces for the current research. 

 

The applied stubbing forces used during the experiments were chosen in a way that the data 
points related to these forces describe the trend of the calculated relative contact area well. The 

chosen stubbing forces were 0.1, 0.2, 0.5, 1.0 and 7.0 N, see the dots in Figure 25. A force 
overshoot was measured in the tensile tester, which was larger for the higher stubbing forces. 
So, to achieve the desired stubbing forces, the following values for 𝐹𝑚𝑎𝑥  were set in the tensile 

tester software: 0.1, 0.2, 0.5, 0.97 and 6.73 N. The stubbing forces that are further mentioned 
in this report are the resulting forces and not the set forces.  

 

 Measurement of external factors 

The ambient temperature and relative air humidity near the tensile tester were measured every 
half hour during stubbing, because changes in these conditions might influence the experiment 

results. The effects of these environmental conditions were not further analysed. 
 

   
Figure 26 Digital thermometer (left) and analogue hygrometer (right). 
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 Counting micro-traces 

Microspheres were counted on the tapes after these were used to lift microspheres from the 

substrates. Before and after tape-lifting, microspheres were counted on the substrates as well. 
Counting was done as follows. Firstly, images of the tape and substrates were constructed by 

using a light microscope: the Keyence VHX-5000 Digital Microscope. Then the images were 
processed in Photoshop in order to discriminate the microspheres from the background. Finally, 

a self-made MATLAB script was used to automatically count the microparticles using image 

recognition routines. 
 

2.7.1 Microscopy 

To create pictures of the substrates and tapes, these were placed on the XY stage of the Keyence 

microscope under the 200x zoom lens. The substrate was positioned horizontally by placing the 
ends of the spools (where no threads were wound around) on two supporting metal strips. The 

stub was positioned horizontally in a self-made holder, see Figure 51 in Appendix B.   
Tape and glass surfaces were captured by 2D image stitching: the microscope made 

multiple pictures and automatically stitched these pictures to one picture of the entire tape or 

sample area. For the textile substrates 3D image stitching was used. For this, the microscope 
not only stitched multiple pictures in the XY-plane together, but also in the Z-dimension. At each 

location in the XY-plane, the lens moved over the Z-axis while capturing the substrate at every 
24 𝜇𝑚. From these pictures with different focal planes, only the areas with in-focus data were 

extracted and combined to create a completely sharp picture that also included data of the 

height profile of the image [11].  

For every picture, the same lighting, recording and stitching settings were used, which 
are displayed in Figure 27. The lighting was equal for textile substrates and the tape, but the 

glass was illuminated less, because the image would otherwise be overexposed due to the strong 
reflection of the glass. For 3D image stitching an upper and lower limit had to be specified. The 

upper limit was specified as the position of the lens at which the extruding fibres were in focus. 

The lower limit was defined as the position at which the steel substrate base was in focus. 
However, in some sample circles of the crochet polyester substrate, there was no steel visible. 

For these substrates, the lower limit was defined as the position in which even the deepest fibres 
were just out of focus.  

 
 

 
Figure 27 Used settings for the Keyence VHX-5000 Digital Microscope. 

Lighting RGB:  [700 256 420] 
Light intensity:  Full ring  

            Transmitted illumination: off 

            Epi-illumination: 60 (textiles and tape) / 17 (glass) 
Shutter speed:  Manual, 15 ms 
Gain:   Manual,  2.5 dB 
HDR:   No 
 

Rec settings Rec size:  Standard [1600x1200] 
 

Stitching  Set range:  (Top, right, bottom and left of the substrate’s  
sample circle or the tape) 

Z set (only for 3D stitching): 
Set upper:  (Extruding fibres in focus) 
Set lower:  (Metal substrate base in focus) 
Vertical Pitch:  Manual, 24 μm 

 
Settings for saving 3D images (height profile and reference picture) 

Height: 0 (display scale in height direction was set to 0, 
otherwise it would distort the 2D image) 

  Scale:  OFF 
  Save 3D data:  ON (height profile) / OFF (reference picture) 
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Before stubbing and after stubbing, three pictures of each sample circle were saved, see Figure 

28. Firstly, the original stitching result was saved. This picture was used to detect the 
microspheres in it. Secondly, the picture was opened in the 3D menu, using the settings that 

are displayed in Figure 27. In this menu, the height profile was saved: an image with colours 
that indicate the height of the surface structure. To be able to overlay the normal image and 

the height profile accurately, the sample circle had to be detected in both images. In the height 

profile, this was not doable, because there was too little contrast between the sample cover and 
the substrate. Therefore, a reference picture was saved. This picture was similar to the height 

profile, but then with colours of the normal picture instead of the colours that indicate the height.  
 

 

     
     Original stitching result            Height profile           Reference picture 

  PolcrochA1_prestub_normal.jpg         PolcrochA1_prestub_height.jpg              PolcrochA1_prestub_refheight.jpg 

Figure 28 Example of the three resulting pictures from one sample circle on textile (crochet polyester 
before stubbing). From left to right: the original picture, that was detailed enough to detect the 

microspheres in it, the height profile, and the reference picture that was needed to overlay the height 
profile and the normal picture. 

 

 

After stubbing, pictures of the stub-tapes were saved too, see Figure 29 for an example. 

 

 

 
Figure 29 Example of a picture of a stub after stubbing (Stub1A2.jpg).  

 

stub 

tape 
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2.7.1.1 Tilt correction in the height profile picture  

Some substrates were not situated completely horizontal relative to the lens, probably due to a 
fibre or another particle between the substrate and its metal supports. This could be seen by an 

incorrect colour gradient in the picture. This is demonstrated in the left picture in Figure 30, 
where the left part of this picture seemed to be higher (closer to red) than the right part. The 

‘3D tilt correction’ function was used to compensate the tilt in the height profile. Therefore, 3 

points were selected that were defined in the same horizontal plane. If the adjustment resulted 
in a well-balanced colour profile, see for example the right picture in Figure 30, the image was 

corrected and then saved. 
 

 

                   
Figure 30 The left picture is tilted and should therefore be corrected. Tilt correction was done by 

selecting three points in the same horizontal plane (see white marks in the left picture). 

 

2.7.2 Image processing in Photoshop 

To simplify automatic counting of the microspheres, the microscope images of the tape and 

substrates were processed in Adobe Photoshop CS6. A succession of multiple image editing 
steps resulted in a binary image in which the microspheres could be discriminated from the 

background, see the transition from image 1 to 2 in Figure 31. These editing steps were recorded 
into a Droplet, which is an application made in Photoshop that repeats a processing sequence 

on a batch of photos by only dragging and dropping them to the Droplet application. The used 
editing steps and how the Droplet was created are described in Appendix I. 

 

   
Figure 31 A section of a crochet polyester substrate with microspheres on it (PolcrochA1_prestub): the 

original stitching result from the microscope (left) and the image that was processed by Photoshop 
(right). 

Tilt correction 

1      2 

sphere sphere 

0.1 mm 0.1 mm 
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2.7.3 Image processing in MATLAB 

MATLAB was used to count the number of microspheres in the black and white images that 
resulted from the Photoshop processing, see Figure 32. The MATLAB function that was written 

for this, ‘Define_particle_nr.m’, is given in Appendix J. This function was called by ‘Run_ 

define_particle_nr_substrates.m’ and ‘Run_define_particle_nr_stubs.m’, 

which are also given in Appendix J. The procedure was as follows.  
 

1. The location of the tape centre or sample circle centre was detected in the normal 

microscope picture (the original stitching result). This location is identical to the location 

of the centre in the associated black and white image, because no changes were made 

in the size of the image in Photoshop. 

2. The detected centre location was used as centre of the analysed circle in the black and 

white image. The area outside this circle was masked.  

3. The ‘noise’ (i.e.: the smaller white spots that do not indicate spheres) in the black and 

white image from Photoshop was removed in MATLAB. This can be seen when 

comparing  Figure 31 and Figure 32.  

4. The microspheres were automatically detected by using the function ‘imfindcircle’.  

5. On some microspheres multiple circles were detected. To avoid double counting of these 

microspheres, a maximum tolerated overlap of the circles was set in the MATLAB code. 

If this maximum was exceeded, one of the two overlapping circles was removed. Figure 

32 shows two examples of overlapping circles; the blue circles in the image were 

excluded from the counting because of the overlap with other circles.  

6. To enable validation of the used method, the circles that indicated detected 

microspheres were displayed on the normal microscope image, see Figure 33.  

 

 

 
Figure 32 Particles were detected in the black 
and white image. The blue circles were not 

included in the particle counting, because the 
overlap was higher than tolerated. 

 

 
Figure 33 The circles that indicate detected 
microspheres were plotted in the normal 

microscope image. 

 

The method that was used for counting the microspheres in the microscope images was 
validated. This was done by manually verifying the particle detection in different microscope 

images. The number of particles that were falsely detected by MATLAB and the number of 

particles that were undetected by MATLAB were counted based on visual observations. These 
numbers were both brought to an acceptable level by tweaking parameters in the MATLAB code, 

such as the range of the microsphere radius and the sensitivity of the circle detection, see 
Appendix L.  

 After particle counting by MATLAB, the resulting images (Figure 33 is a section of one 

of those images) were quickly scanned visually. When a closely packed group of falsely detected 

0.1 mm 0.1 mm 
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microspheres was detected, for example on a red toned fibre, the number of these falsely 

detected microspheres was subtracted from the number of detected microspheres. An example 
is given in Figure 34: a picture of a tape sample on which a fibre was causing a lot of falsely 

detected fibres.  
 

 

 

         

Figure 34 Example of microspheres that were falsely detected on a red toned fibre. The number of these 
falsely detected particles was manually subtracted from the total number of microspheres calculated by 

MATLAB. 

 

The distribution of microparticles over the depth of the textile substrates, before and after 

stubbing, was examined to analyse the particle collection efficiency of microparticles from 
different depths in the substrate structure (research question 2). The MATLAB function that was 

written for this, ‘Define_particle_height_textiles.m’, can be found in Appendix J. This 

function was called by ‘Run_define_particle_height_textiles.m’, which is also given 

in Appendix J. The procedure was as follows. 
 

1. Only the part of the sample circle was analysed that was fully covered by the tape 

anyways. Because the placement of the tape was not exactly similar during every tape-

lift, the fully covered area had to be determined according to Appendix K.  

2. The normal microscope picture and the height profile picture were overlaid. Therefore, 

the location of the sample circle in the height profile image was determined by detecting 

the sample circle in the equally sized reference picture (see for example the third image 

in Figure 28). The analysed part of the sample circle in the height profile was masked, 

cut out and scaled to the same size as the normal microscope picture, see Figure 35. 

The normal microscope picture was masked and cut out as well. 

3. The microspheres were counted according to the same procedure as in the function 

‘Define_particle_nr.m’ (now only in the smaller, fully covered sample area). 

Subsequently, the locations of the detected microspheres could be plotted in the height 

profile image, see Figure 35. 

4. The colour (i.e.: RGB-value) at the location of each detected microsphere centre in the 

height profile image was linked to a height value by selecting the best corresponding 

colour in the legend of the height profile image, see Figure 36. The colours in the legend 

colour bar were interpreted as follows. The maximum value in the legend colour bar 

was entered manually in MATLAB (899.41 µm in the example of Figure 36). Based on 

this value, a height value was assigned to all 254 unique RGB-values in the legend 

colour bar by MATLAB. 

199 detected microspheres on stub1G2

fibres 

sphere 
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5. The absolute height of the microspheres do not offer useful information if the reference 

height deviates between different samples. Therefore, the minimum height measured 

in the sample circle was defined. This minimum height was the height of the steel base 

basically. However, as mentioned in subparagraph 2.7.1 the steel base was not visible 

in every substrate of crochet polyester, and therefore the minimum height was 

sometimes defined by the deepest detected fibres in these samples. This minimum 

height in the sample circles was subtracted from the absolute heights of the 

microspheres that was measured to get the relative distance from the substrate base 

(or relative distance from the deepest fibres for some crochet polyester substrates). 

 

 

 
Figure 35 The microscope image was masked and cut out (left) and the corresponding height profile 

image was masked, cut out and scaled to the same size as the original stitching result. The microspheres 
that were detected in the image were plotted in both images.  

 

 
 

 
Figure 36 Legend colour bar of one of the height profile images. It consists of 254 unique RGB values 
that match to colours in picture. Every RGB-value on the legend was assigned a unique height value. 

 

  

254 
RGB-values 
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 Data analysis 

2.8.1 Collection efficiency for different stubbing forces 

The collection efficiency of microspheres, 𝜂𝑐𝑜𝑙𝑙𝑒𝑐𝑡𝑖𝑜𝑛  [%], was calculated by dividing the number 

of microspheres detected on the stub tape by the number of microspheres that were present 

before stubbing at the substrate surface area that was covered by tape. However, this second 

number of microspheres could not be determined directly, because the exact placement location 
of the tape on the substrate is unknown. Therefore, the particle density on the substrate before 
stubbing, 𝜌𝑠𝑢𝑏𝑠𝑡𝑟𝑎𝑡𝑒 𝑝𝑟𝑒𝑠𝑡𝑢𝑏 [#/𝑚𝑚2], was calculated by dividing the number of detected 

microspheres on the substrate before stubbing by the surface area that was analysed, see 

equation 2.4. 
 

𝜌 𝑠𝑢𝑏𝑠𝑡𝑟𝑎𝑡𝑒 𝑏𝑒𝑓𝑜𝑟𝑒 𝑠𝑡𝑢𝑏𝑏𝑖𝑛𝑔 =
𝑛𝑠𝑢𝑏𝑠𝑡𝑟𝑎𝑡𝑒 𝑏𝑒𝑓𝑜𝑟𝑒 𝑠𝑡𝑢𝑏𝑏𝑖𝑛𝑔

𝐴𝑠𝑢𝑏𝑠𝑡𝑟𝑎𝑡𝑒

 Eq. 2.4 

 
The particle density was used to estimate the number of microspheres on the surface area of 

the substrate on which the tape was placed. Thereby, the collection efficiency could be 

calculated, see equation 2.5. 
  

𝜂𝑐𝑜𝑙𝑙𝑒𝑐𝑡𝑖𝑜𝑛 =
𝑛𝑡𝑎𝑝𝑒

𝐴𝑡𝑎𝑝𝑒 ⋅ 𝜌𝑠𝑢𝑏𝑠𝑡𝑟𝑎𝑡𝑒 𝑏𝑒𝑓𝑜𝑟𝑒 𝑠𝑡𝑢𝑏𝑏𝑖𝑛𝑔

⋅ 100% Eq. 2.5 

 

 
For each combination of substrate material and stubbing force, the mean collection efficiency of 

3 trials was calculated. Statistical analysis of this data was not possible because of the limited 
amount of data points. Therefore, descriptive statistics was applied. Per substrate material, a 

curve was fitted to the mean collection efficiencies, to indicate the overall trend of collection 
efficiency over increasing stubbing force. These curves were compared to the graphs of the 

relative contact area vs. the used stubbing force.  

Furthermore, it was analysed if there was a correlation between the collection efficiency 
of microparticles from a textile sample and the number of microparticles that were present on 

that sample before stubbing. This was done so that a potential difference in the number of 
microparticles on the substrates would not influence the test results without being noticed. 

 

 

2.8.2 Distribution of microspheres over the height of the textile substrates before 

and after stubbing 

The distribution of microspheres over the height of the textile structure before and after stubbing 

was compared. Therefore, five ‘height levels’ were distinguished per substrate material. These 
height levels defined equal height ranges between 0 𝜇𝑚 (which should indicate the height of 

the steel substrate base) and the height of the heighest detected particle relative to the base 

(this can be larger than the diameter of the thread due to extruding fibres). The difference 

between the number of detected microspheres before and after sampling was calculated per 
height level, see equation 2.6. If the microspheres do not displace on the substrate, apart from 

being captured by the adhesive tape, this (negative) number indicates the number of collected 
microspheres per height level.   

 
(𝑛𝑠𝑢𝑏𝑠𝑡𝑟𝑎𝑡𝑒 𝑎𝑓𝑡𝑒𝑟 𝑠𝑡𝑢𝑏𝑏𝑖𝑛𝑔,𝑖 − 𝑛𝑠𝑢𝑏𝑠𝑡𝑟𝑎𝑡𝑒 𝑏𝑒𝑓𝑜𝑟𝑒 𝑠𝑡𝑢𝑏𝑏𝑖𝑛𝑔,𝑖), where 𝑖 = 1 … 5 Eq. 2.6 
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3. 
 Results 

 Adhesive performance of tape after UV irradiation 

The mean maximum adhesive force between the 10 mm diameter adhesive tape and the glass 

substrate over each set of trials was calculated and the results were compared, see Table 2 and 

Figure 37. UV irradiation by both the setup of the NFI and the TU Delft turned out not to have 
a noteworthy effect on the maximum adhesive force between the tape and the glass. It can be 

seen that the variation in adhesive forces between the differently UV irradiated tapes is small, 
and not consistent over the various applied stubbing forces. Though, the UV irradiation had a 

notable effect on the colour of the tape, which indicates that there had been a physical change 
in the tape. It is possible that the colour change is a result of a chemical change in the backing 

of the glue, which is a UPVC film [6].  

 
 

 
Table 2 The measured maxima of the adhesive forces between adhesive tape and glass are displayed for 

not UV irradiated tape, tape that was UV irradiated at the TU Delft and tape that was UV irradiated at the 

NFI. The maximum adhesive forces that are measured with a stubbing force of 9 N are displayed 

together with their standard deviations.  

 
UV irradiation 

No UV UV TUDelft UV NFI 

S
tu

b
b

in
g

 f
o

rc
e

 

1 N (n=3x3) 2.55 N 2.35 N 2.65 N 

3 N (n=3x3) 5.06 N 5.7 N 5.00 N 

9 N (n=6x3) 8.45 (±1.32) N 8.02 (±0.53) N 8.83 (±2.01) N 
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Figure 37 Mean maximum adhesive force measured between adhesive tape (10 mm diameter) and glass 

after stubbing with 1, 3 and 9 Newton. Three different tape types were tested: not UV irradiated tape 
(No UV), tape that was UV irradiated with the setup that was designed at the TU Delft (UV TUDelft), and 

tape that was UV irradiated according to the procedures of the NFI (UV NFI). 

 

 

 

 
Figure 38 There was a notable colour difference between tape that was not UV irradiated (left column) 

and tape that was UV irradiated in the setup that was developed at the TU Delft (middle column). A 
smaller colour difference was visible between the tape that was not UV irradiated and the tape that was 

UV irradiated according to the procedures of the NFI (right column). 

 

  

         No UV                UV TUDelft               UV NFI 
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 Collection efficiency for different stubbing forces 

In Figure 39 the collection efficiency of microparticles can be found for all used stubbing forces 

on three different substrate materials. It can be seen that some stubbing forces were not exactly 
equal to the intended stubbing forces. This was due to overshoot in the tensile tester. This 

overshoot was already considered when the maximum force was set in the software that 
actuates the tensile tester. However, it can be seen that the force overshoot differed between 

substrate materials and between trials. The collection efficiencies were calculated based on the 

raw experiment data that is displayed in Appendix M. 
 

 
Figure 39 Collection efficiencies of microspheres when stubbing at about 0.1, 0.2, 0.5, 1 and 7 N. The x-

marks indicate the individual trials (n=3). Results are displayed for all three substrate materials. 

 
 A curve was fitted through mean collection efficiencies according to an exponential 
behaviour 𝑦 = −𝑎 ⋅ 𝑒−𝑏⋅𝑥 + 𝑐, see Figure 40. This plot shows the overall trend that was specified 

by the data points.  
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Figure 40 Curves were fitted through the mean collection efficiencies that were plotted over the used 
stubbing forces (represented by the dots in the graph) according to the expected behaviour, which is 

increasing and which stagnates at a certain force (𝑦 = −𝑎 ⋅ 𝑒−𝑏⋅𝑥 + 𝑐), using the least squares method. 

 

The correlation between the number of microspheres on the substrates before stubbing and the 
collection efficiency when stubbing from these substrates is visually displayed in Figure 41.  

 

 
Figure 41 Collection efficiency versus the number of microspheres on the substrate before stubbing for 
the different textiles: sewing polyester (PS), extra strong sewing polyester (PSS) and crochet polyester 

(PC).  
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 Distribution of microspheres over the height of the textile 
substrates before and after stubbing 

Microscope images of the textile substrates before and after stubbing were compared using 

MATLAB. An example of how this was visualised is displayed in Figure 42. 
 

           Before stubbing: 

 
           After stubbing: 

 
Figure 42 Example of resulting images after particle detection and overlap with the height profile before 
and after stubbing (PolcrochA1). In this example it can be seen that three particles are disappeared and 

two are not moved. 

 

 

The difference between the number of detected microspheres before and after stubbing 
(𝑛𝑎𝑓𝑡𝑒𝑟 𝑠𝑡𝑢𝑏𝑏𝑖𝑛𝑔 − 𝑛𝑏𝑒𝑓𝑜𝑟𝑒 𝑠𝑡𝑢𝑏𝑏𝑖𝑛𝑔) on sewing polyester was displayed per height level, Figure 43. 

This data is based on 3 trials per stubbing force. The raw data of these trials is displayed in 

Table 7 in Appendix N. The difference in number of detected microspheres over all five height 
levels together is displayed in the legend of Figure 43. To support the interpretation of this data, 

the mean distribution of microparticles on sewing polyester substrates before stubbing is 
displayed in Figure 44. For the other substrate materials similar results were obtained and these 

are displayed in Appendix N. 
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Figure 43 The difference between the number of microparticles after and before stubbing on sewing 
polyester. In the sample circles, only the area was analysed that was fully covered by tape (n=3). 

  

 

Figure 44 Mean distribution of microparticles on sewing polyester substrates over the height levels before 
stubbing (n=3x5). The red lines indicate the standard deviation between the trials.  

 

 Other measured external factors 

During stubbing, the ambient temperature varied between 21 and 24 degrees Celsius. 

The relative humidity of ambient air varied between 38 and 36 % (±5 %).  
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4. 
 Discussion 

Microspheres were deposited on different textile substrates, and collected from these substrates 

by using stubs. The influence of the used stubbing force, that was applied using a tensile tester, 

on the trace collection efficiency was analysed. The trace collection efficiency was determined 
using visual quantification of the microspheres on the substrates and the stub-tapes. The results 

showed an increase of collection efficiency with an increasing stubbing force, which is discussed 
in paragraph 4.1. The collection efficiency from selective heights in the substrate structures was 

analysed to see if layered collection would be possible, see paragraph 4.2. Recommendations 
are given in paragraph 4.3. Finally, the results of this research are placed in its wider context 

and recommendations for future research are given in paragraph 4.4.  

 
 

 

 Collection efficiency for different stubbing forces 

On all textile substrates, the mean efficiency of the collection of microspheres increased with 

increasing stubbing force in a concave down increasing function. This matched the expectation 

that the collection efficiency would increase in a similar manner as the actual contact area 
between the tape and the substrate. A more detailed comparison between the collection 

efficiencies (Figure 40) and relative contact areas (Figure 25) was not made, because the 
calculated relative contact areas were not accurate enough, as described on page 26. Moreover, 

the collection efficiency was not only defined by the contact area, but also by the distribution of 

microspheres over the depth of the substrate material. 
 The collection efficiency of microspheres increased most quickly among low stubbing 

forces up to about 1 N. The rise of collection efficiency with increasing stubbing force stagnated 
between 3 and 12 N according to the fitted curves, see Table 3. These results indicate that 

stubbing with a stubbing force higher than 12 N would not be really useful when requiring a 
maximum collection efficiency on the variety of substrate materials that was tested. However, 

based on the fitted curves, the theoretical maxima of the collection efficiencies are far below 

100% . These results suggest that it might be more useful to stub multiple times on the same 
location of a substrate when the goal is to collect as much as possible than to further increase 

the stubbing force. 
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Table 3 Theoretical maxima of the collection efficiencies and calculated stubbing forces at which the 
increase of collection efficiencies stagnated (defined as 5% (absolute number) from theoretical 
maximum) for different substrate materials.   

 Theoretical maximum 
collection efficiency 

 

 

Stubbing force at stagnation 
of collection efficiency (5 % 
below theoretical maximum)  

 

Sewing polyester 69 % 12 N 

Extra strong sewing polyester 38 % 3 N 

Crochet polyester 78 % 6 N 

 
 

When the particles were counted, deviations of the counted number of particles with respect to 

the true number of visible particles were caused in two ways: particles were undetected by the 
used method or particles were falsely detected (for example on a red toned fibre as in Figure 

34). The number of undetected particles depends on the number of present particles (if no 
particles are present in a sample, there can be no undetected particles). The number of falsely 

detected particles depends on the size of the area that was analysed more than the number of 

visible particles. Therefore, the proportion of falsely detected particles relative to the number of 
present particles is especially high for low collection efficiencies.  

To calculate the collection efficiencies, several assumptions were made. Firstly, a visual 
method was used to quantify the number of particles. This means that particles present at the 

textile substrates could be invisible, because these were covered by fibres or other particles. On 
the tape, particles could only be overlapped by other particles. This suggests that there are 

probably much more undetected particles on the substrates than on the tape, and therefore the 

true collection efficiency was probably lower than displayed in Figure 39 and Figure 40.   
 Another assumption that was made, was that the tape and the substrate were two 

parallel surfaces, what would result in a homogeneous pressure distribution over the tape. 
However, the observable inhomogeneous distribution of microspheres over the surface of the 

tape after sampling glass indicate there was no homogeneous pressure distribution in the 

contact between tape and glass, see Appendix O. Therefore it is likely that the surface of the 
tape and the textile substrates were tilted relative to each other as well during stubbing. 

However, this was not notable when observing the tapes that sampled the textile substrates. 
The deformability of the textile resulted in a more equal pressure distribution between the tape 

and the substrate than between the glass and the tape.  

 
 

  



Discussion 

43 

4.1.1 Number of microspheres on the substrate before stubbing vs. trace 

collection efficiency 

Figure 41 shows that the number of microspheres on the substrates before stubbing differed 

among different samples. The intention of the used material deposition method was to deposit 
about 1000 microspheres on the surface area of the sample that was to be covered by tape, 

which indicates that there should be about 1.6E3 particles in the analysed part of the sample 

circle before stubbing. However, in practice there were much less particles detected on the 
analysed parts of the sample circles on the substrates (on average 673 on crochet polyester, 

402 on sewing polyester and 346 on extra strong sewing polyester). One of the causes for this 
is that the suspension of ethanol was spread out so fast, that the liquid also penetrated in the 

textile on the other side of the spool, which is known because moisture was detected beneath 
the spools after material deposition. This caused the particles to be distributed over a larger 

surface area than was intended when this method was designed. An additional explanation is 

that some particles were undetectable by the microscope, because these were covered by the 
threads.  

   Within sets of 3 trials (same stubbing force and same substrate material used), there 
was no consistent trend in the relation between the collection efficiency and the number of 

microspheres present on the substrate before stubbing, see Figure 41. Therefore, it was 

assumed that the existing differences in particle density on the substrates before stubbing did 
not influence the collection efficiencies.  

 

 Collection efficiencies at different height levels of the substrate 
structure  

The number of detected microparticles in defined height levels of the substrates differed after 
and before stubbing. This had several potential causes. Firstly, if this difference is negative 
(𝑛𝑎𝑓𝑡𝑒𝑟 𝑠𝑡𝑢𝑏𝑏𝑖𝑛𝑔 <  𝑛𝑏𝑒𝑓𝑜𝑟𝑒 𝑠𝑡𝑢𝑏𝑏𝑖𝑛𝑔), material was possibly collected by tape. However, there are 

several other possible explanations. Microparticles could have been moved over the substrate 
material, and end up in another height level. Furthermore, particles may have become visible or 

invisible by displacement of the fibres. This latter phenomenon was also visually detected, see 

Figure 45. This phenomenon affirms that stubbing one the same location on the evidentiary 
item more than once can be beneficial to optimize the overall collection efficiency. Moreover, 

the displacement of microspheres and fibres results in the fact that the applied method is not 
suitable for determining form what height the collected particles originated. This is only possible 

when the initial locations of the collected particles can be deduced. To do so, a new method 
should be designed.  

 Though, the acquired data of the impression of the polyester threads and adhesive tape 

under an increasing stubbing force already gave some insight in the collection efficiency from 
different height levels. When stubbing with 1 N, the impression of the tested substrate materials 

almost reached its maximum. This means that it is likely that contact with deeper layers of the 
substrate is made when applying 1 N, by which it is possible that material is collected from 

deeper layers of the substrate. Therefore, it is likely that selective collection of superficial traces 

is only possible when using a stubbing force far below 1N. 
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Figure 45 A crochet polyester substrate before (left) and after (right) stubbing. It can be seen that by 

displacement of the fibres and the microspheres, some microspheres moved to a more superficial 
position in the substrate (indicated by the blue circles in the right image). 

 

4.2.1 Inaccuracies 

There were falsely detected and undetected particles in the images of the substrate as discussed 

above. When the overall collection efficiency (from all heights in the substrate together) was 
calculated, the falsely detected particles on large irregularities could be manually subtracted 

from the sum of detected microspheres. However, when the height of detected particles was of 
interest, this was not feasible, because therefore the height information of each individual 

particle that was falsely detected should be determined and should be removed from the total 

data manually. Another observation was that the number of falsely detected particles was larger 
after stubbing than before stubbing. Oxidation of the steel substrate base could possibly be an 

explanation for this phenomenon, because hereby the metal would get a more red tone, similar 
to the colour of the microspheres, see Figure 46. However, not only on the metal, but also on 

the fibres more particles were detected. An explanation for this phenomenon cannot be given, 

because all settings of the microscope, Photoshop CS6 and MATLAB that were used to analyse 
the samples before and after stubbing were equal, except from the exact upper and lower limit 

of Z-range over which the microscope lens moved. However, this difference does not offer an 
explanation for the observed difference in falsely detected particles before and after stubbing. 

 The resolution of the height profile image was limited compared to the normal image. 
However, 1 pixel in the height profile was smaller than the size of a microparticle, so considering 

this the height profile image could be used as indication of the height of a particle.  

Furthermore, the overlap between the normal photo, that was used for particle 
detection, and the height profile was limited, because the centre of the sample circle that was 

detected in the normal picture did not always exactly match the centre that was detected in the 
height profile (by using the reference picture, see Figure 28). An inaccuracy of this resulted in 

the fact that particles were not projected on the right spot in the height profile. 

 Finally, the reference height in the height profile image could not always be defined by 
the height of the steel base. In samples of crochet polyester (the thickest thread, with least free 

space between the threads) the lowest detected height in the profile was defined as reference 
height. However, this height can be different between samples, and therefore this gives a 

deviation when comparing the results of multiple samples.  
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Figure 46 Oxidation of the steel substrate base resulted in falsely detected particles (PolsewstrA1 before 
stubbing). Possibly, further oxidation in the time between the pictures token before stubbing and after 

stubbing resulted in a higher total number of falsely detected particles on the metal substrate base after 
stubbing. 

 
Most of the mentioned limitations can be solved by some changes in the used method. These 

recommendations are given in paragraph 4.3. 

 

 Recommendations to improve the used method 

4.3.1 Improve particle detection 

A better distinction between microspheres and the background could be improved by the 

following adjustments. The steel substrates have to be painted black, just as the stub-pins. A 
large proportion of the falsely detected microspheres was detected on the steel, because of its 

red tone. The number of falsely detected microspheres on the fibres could probably be reduced 
by using a lower light intensity of the microscope light. This should reduce the red tone in the 

fibres resulted by the over-exposure of light. When reducing these risks of falsely detecting 
particles, the sensitivity used in the particle detection method could probably be set higher, what 

will subsequently result in less undetected particles on the textile substrates as well. 

 In this method, a well-considered choice was made to deposit the microparticles on the 
substrates by using a solvent. This resulted in a homogeneous distribution without 

agglomerations of particles. However, the disadvantage of this method is that particles can 
penetrate in the fibres, by which the particles get invisible, what leads to an inaccuracy in the 

quantification of particles. One alternative to solve this, is to find a new method to equally 

distribute dry particles upon the substrate. Another alternative would be to know the 
concentration of microspheres in the solvent that is deposited (just as it was known in these 

experiments) and to know on which surface area this solvent spreads out (which was unknown, 
because the solvent flowed beyond the edges of the substrate spools). A potential way to set 

this surface area, is by using water in the solvent instead of ethanol. It was observed that a 
water droplet did not flow out over the used substrates well. This is caused by the higher surface 

tension of water relative to ethanol. If a droplet of a water-based solvent evaporates, particles 

in the solvent will be distributed over the surface area of the droplet. 
 

4.3.2 Improve determination of particle depth location 

Close to every sample circle there should be a visible part of the metal support, so this could be 

defined as reference height. By a consistent definition of the reference height, the height of 

microparticles relative to this reference can be compared properly between different samples. 
 The overlap between the detected sample circle in the normal microscope image and 

the height profile would probably be more accurate if the edge of the circle in the sample cover 
was smoother. In these experiments, the sample circles had rippling edges as a result of the 

steel base 

thread 
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low accuracy of the laser cutter by which the sample covers were produced. This also reduced 

the detection accuracy for this circle. Another solution would be to place reference marks on the 
sample cover that can visually be detected by MATLAB.  

 
 

More insight is specifically desired in the way how traces can selectively be collected from merely 

the top layer of the substrate. This is most likely only possible when using low stubbing forces, 
and thus when the collection efficiencies are low as well. The difference between the number 

of particles that can be found on the substrate before and after stubbing will therefore be really 
small, so even small inaccuracies in the used method would have a large impact. Therefore, it 

is relevant that if more insight is desired in the collection of traces from selective depths of 
textile, the used method has to be considerably accurate.  

 

 

 Future research 

To see how the results of the current study can be implemented further, this experiment was 

placed in its wider context, see Figure 47. Based on this context, recommendations are given 
for future studies on the five topics that are also displayed in Figure 47. 

 

 

 
Figure 47 DNA transfer process from a DNA source to a sample. The numbered remarks indicate the 

recommendations for future studies. 

 

 
1. Study influences on micro-trace distribution  

To the best of our knowledge, there are no studies that analysed the distribution of trace DNA 

(or other micro-traces) on textiles or other substrates. However this distribution will determine 
to what extend it would be possible to selectively collect a targeted trace from a substrate by 

adapting the stubbing force. A similar particle detection method as used in this research (with 
adjustments as recommended in paragraph 4.3) can probably be used to analyse trace 

compositions.  
The distribution of traces over textile is influenced by multiple factors: the DNA source, 

the activity by which DNA is transferred and ageing of the trace. The material properties of the 

DNA-containing material that is secreted by the DNA source is not unambiguously. Trace DNA 
can consist of different body secretions: skin cells, DNA carried by sweat or sebum and highly 

nucleated body fluids from the eyes, nose or mouth [1]. It is likely that these different body 
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secretions are distributed differently over a substrate. Wet traces could for example penetrate 

deeper in the substrate material than dry traces.  
 The activity indicates all actions by which DNA is transferred. Goray et al. [12] 

demonstrated that in general significantly more trace DNA was transferred by friction than by 
passive or pressured contact (from one to another substrate). Ladd et al. [13] demonstrated 

that prolonged contact time during dynamic contact (what means that contacting surfaces slide 

over each other) does increase the amount of DNA that is transferred from a DNA source to a 
substrate. This statement is not true for static contact [14][15]. In short, of multiple 

distinguishable activities it is known that they influence the amount of transferred DNA traces. 
However, something that is useful to know as well is the distribution of traces over the depth of 

the substrates after different activities. If this is known, the collection technique can be adapted 
to it in order to increase the ratio between targeted trace and noise in the sample. In practice 

there are usually multiple DNA deposits on an evidentiary item. Therefore, it is also useful to 

test the influence of the deposition of a second trace on the distribution of an earlier deposited 
trace. To do this, distinguishable traces should be used.  

Ageing indicates all influences on the DNA trace in the time between the trace 
application and collection. To implement knowledge about the relation between activity and 

trace distribution into stubbing procedures, it is of high importance to investigate how actions 

of the forensic investigators would change the trace distribution, for example by packing and 
transporting an evidentiary item in a paper bag.  

 Finally, substrate properties will not only affect how traces are removed from it, but 
also how traces are distributed by the deposition.  

 
 

 

2. Obtain more collection efficiency data 
This research gives new insight in the increase of micro-trace collection efficiency with increasing 

stubbing force for the tested materials. However, the collection efficiency should be defined for 
a wider variety of substrate materials and micro-traces too, because these materials influence 

the trace collection by various properties, as illustrated in Figure 48. The thickness and bulk 

stiffness of the textile determine the impression of the textile with a certain stubbing force. The 
structure of the substrate, such as the weaving type, determines the actual contact area 

between the tape and the textile that is achieved by a particular impression of the textile. The 
adhesive properties of the substrate and the micro-traces determine the relation between the 

actual contact area and the trace collection efficiency.  

The microspheres used in this experiment differed from DNA-containing particles in size, 
shape and other mechanical properties, what influenced the adhesive bonding and thereby the 

trace collection efficiency. However, to make a statement about collection efficiency of trace 
DNA under specific conditions in general is not doable, because the content of trace DNA can 

also vary a lot [1]. 
A new method should be designed to study the relation between the used stubbing 

force and the possibility of collecting traces from specific depths in the substrate structure (deep 

or superficial), see recommendations in paragraph 4.2. Selective collection is expected to be 
related to the relative impression of the textile, which indicates the impression of the textile 

relative to its thickness. Therefore, it will be useful to measure the relation between the relative 
impression and the substrate depth from which traces are collected at the same time.  
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Stubbing force  
  

Impression 
 

  Actual contact area 
 

Collection 
  of textile     between tape + textile   of microparticles 
       

Relation is defined by 
substrate thickness 
and bulk stiffness 

 Relation is defined by 
structure of the 
substrate (weaving 
type etc.) 

 Relation is defined by 
adhesive properties of 
micro-traces and 
substrate 

Figure 48 Visualisation of how properties of the substrate and microparticles influence the trace collection 
when stubbing. 

 

 

 
3. Classify substrates of real evidentiary items 

To give an estimation of the stubbing force that should be used to selectively collect micro-
traces from the top layer of a textile evidentiary item, a method should be found to measure 

the relative impression of textile with increasing stubbing force. Based on the relation between 

the relative impression and the trace collection on the tested substrates, the stubbing force can 
be defined to collect material from a certain depth in the substrate. To enable measurement of 

the impression of textiles, it is really important how the moment of initial contact is defined, 
which is not unambiguously due to extruding fibres and irregularities in the surface structure. 

When determining the relative impression for a textile, it should be taken into account that there 
are exceptions, such as textiles with superficial prints on it. For these textiles, the impression 

would influence the collection of micro-traces differently.  

The overall collection efficiency of micro-traces from textile depends on many substrate 
properties. These properties can widely vary between evidentiary items. Therefore, it is not 

practical to classify the substrates based on all these specific properties and to determine the 
relation between the stubbing force and the trace collection efficiency for all these substrates. 

However, based on data that will be obtained, a statement for a more general group of 

substrates (in terms of structure and adhesive properties) can be given about the minimum 
stubbing force that is needed to approach the theoretical maximum collection efficiency (>95% 

of the theoretical maximum). The exact stubbing force when requiring as much of the traces as 
possible from a textile is not of noteworthy influence anyhow. 

 

 
 

4. Design stubbing force limiter 
The results of this research suggest that the efficiency of the collection of micro-traces from 

textile, as well as the estimated actual contact area between the tape and the substrates, 
particularly increases among stubbing forces up to 1 N. The estimated actual contact area was 

considered to be nearly complete at a stubbing force of 1 N. Therefore, selective collection of 

material from the top layer is probably only possible far below 1 N. Forensic investigators now 
seem to use a stubbing force in the range between 1 and 10 N. This force range is based on a 

study of Wendt in 2013 [4], in which the stubbing force was measured that was used by forensic 
investigators during stubbing on different textiles that were placed over mock-up skin. There 

was a lot of variation in stubbing forces between repeating trials, which indicates that it is hard 

to control the stubbing force manually. Moreover, the stubbing forces that can probably be used 
to collect traces from selective layers of the substrate are much lower than investigators seem 

to use, so a limiter of the stubbing force will be needed to enable selective trace collection.  
Wendt [4] designed a stubbing force indicator that could be coupled to a stub holder. 

In this mechanism there was an adjustable spring to set the desired stubbing force. An indicator 
light in the mechanism turned on when the desired stubbing force was reached. This instrument 

had a force range between 5.9 and 8.8 N. In 2014 an improved stubbing force limiter was 

designed by a BSc. project group at the TU Delft [16]. This design could mechanically limit the 

Stubbing 
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stubbing force by using a pressure reducing valve. The range of stubbing forces that could be 

achieved with this mechanism was 2.10 to 30 N, with a standard deviation of about 0.5 N. Based 
on what is known now, the force range must be even lower and standard deviation should be 

much smaller to use a stubbing force limiter to collect traces from only the top layers of textiles. 
However, the exact range of stubbing forces is yet to be defined based on knowledge of trace 

distributions, textile properties and collection efficiencies that should be obtained first. A 

mechanical force limiter is recommended, because when requiring really low stubbing forces, 
the chance of exceeding this force limit is very high if only an indication light is used.  

 
 

 
5. Adapt stubbing procedure 

When all previously mentioned issues are investigated, together these results may answer the 

following question: If multiple DNA sources deposited trace DNA on the same substrate, how 
does the use of different stubbing forces influence the collected amounts of these different DNA 

traces and the ratio between it? 
 If it turns out that traces are totally mixed up instead of being layered, the only goal is 

just to collect as much material as possible. Therefore, a stubbing force of at least 3 to 12 N 

can be used. The exact force does not matter because the collection efficiency does not 
significantly differ in the higher range of stubbing forces. It should be taken into account that 

there might be other material, or fibres of the substrate itself, that are undesired to be collected 
in the DNA sample. Some materials inhibit the further processing of the DNA sample by which 

a DNA profile is created, for example denim, leather, and various soiled items [17]. If these kind 
of materials are present on the substrate, this might change the desired stubbing technique.  

If a targeted DNA trace is positioned on top of other traces, a low stubbing force should 

be used. If a targeted DNA trace is positioned below other traces, it might be useful to stub 
twice: first with a low stubbing force to remove the top traces, and subsequently with a higher 

stubbing force to collect the desired trace from deeper layers in the substrate. 
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5. 
 Conclusion 

The experiment results suggest that the collection efficiency of microspheres increases with 

increasing stubbing force in a concave down increasing function. This was tested on three textile 

substrate materials: flat spools of sewing polyester, extra strong sewing polyester and crochet 
polyester threads. The results were in line with the expectations, because the collection 

efficiency is related to the contact area between the tape and the substrate, which increases in 
a similar manner with increasing stubbing force. According to a fit through the measured 

collection efficiencies (measured for stubbing forces of 0.1, 0.2 0.5, 1 and 7 N), the collection 
efficiencies seemed to stagnate at 3, 6 and 12 N (for extra strong sewing polyester, sewing 

polyester and crochet polyester, respectively). Stubbing with a force higher than 3 to 12 N 

(depending on the substrate material) does not notably influence the collection efficiency. 
However, because the theoretical maxima of the collection efficiencies were far from 100%, it 

is highly likely that stubbing multiple times on the same spot of a substrate increases the total 
collection efficiency. This is caused by displacement of substrate fibres and microparticles during 

stubbing, which was visually observed in the microscope images, causing unreachable traces 

become reachable for the tape.  
 The designed method was too inaccurate to define the trace collection efficiency from 

different depth locations in the substrate structure. Various recommendations were proposed. 
Yet, the acquired data of the impression of the polyester threads and adhesive tape with 

increasing stubbing force showed that when using a stubbing force of 1 N, the impression almost 

reached its maximum. Thereby, it is likely that material from deeper layers of the substrate is 
collected when applying a stubbing force of 1 N. Therefore, selective collection of superficial 

traces is probably only possible when using a stubbing force below 1N, which is far below the 
range of stubbing forces that are currently used. 

 
The distribution of trace DNA in different scenarios should be analysed to see to what extend 

layered trace deposition can occur. This distribution is defined by multiple factors, which 

influences should be studied: the type of deposited material, the activity by which a trace was 
transferred, the ageing process of the trace, and the type of substrate material. More data 

should be collected over a wider variety of textiles to investigate the effect of the relative 
impression (the impression relative to thickness) of the substrate under a stubbing force, the 

substrate structure and other adhesive properties of the substrate on the micro-trace collection. 

The stubbing force limiter prototype should be redesigned to allow stubbing with a much lower 
and more accurate stubbing force (< 1 N).  

This research is, to the best of our knowledge, the first research that provided insight 
in the relation between the used stubbing force and the collection of microparticles from textile. 

It will contribute to a collection method by which micro-traces on a victim’s jacket that are left 
by the perpetrator can be collected as effectively as possible. 
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Appendix A 
Stub-tape cutting procedure 

 
Required:  

1. Arc punch of 10 mm diameter (see Figure 49) 

2. Wooden plate (see Figure 49) 

3. Steel hammer (see Figure 49) 

4. Tweezers (see Figure 49) 

5. Scissor 

6. Hand gloves 

7. Cleanroom wipes (or paper towels) 

8. Black-painted stub-pins (12.6 mm diameter) 

9. Double sided adhesive Scapa 4405 tape (see Figure 49) (The edges of the tape roll had 

been UV irradiated at the NFI, because this is how the tape rolls are stored there. The 

tape roll was packed in plastic to protect it against contamination.) 

10. Single sided adhesive tape (width: 19 mm, brand unspecified) 

11. Holder for the stubs in a box (see Figure 50 in Appendix B) 

12. Holder for a single stub (see Figure 49 and Figure 51) 

13. Mass with flat base of 2.1 kg (see Figure 49) 

 

 
 

 

Figure 49 Some of the tools that are used to cut the tape. The numbers refer to the list above. 
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Procedure: 

- Wear hand gloves. 

- Clean the tools and the working environment with cleanroom wipes and some ethanol. 

- Clean the stub-pins with a cleanroom wipe and ethanol and put these in the holder in the 

box. 

- Cut a piece of double sided tape with the scissor. Only the ends of the tape can be touched 

by the scissor and tweezers, for these are not punched out. 

- Place a piece of the double sided tape, with the protective silicone paper sticking to it at 

one side, on the wooden plate. The silicone paper should be situated at the bottom side, in 

contact with the wood. If needed, use single-sided tape to stick it to the wood. 

- Clean the inside of the arc pinch by pulling a cleanroom wipe through it (using tweezers) 

up to the half of the towel and then turn the towel around so loose particle insides the arc 

pinch are removed. 

- Place the cutting edge of the arc pinch on the tape on the location where a full(!) circle 

should be punched out. 

- Hit the back of the arc punch with the steel hammer only once heavily. 

- Push the tape out of the arc punch after pressing it from the inside of the arc punch with 

the tip of the tweezers.  

- The round tape can be lifted out of the arc punch using tweezers and placed with the sticking 

side to a clean stub-pin in the holder for a single stub. 

- Press the tape gently with the side of the tweezers to the stub. 

- Press the tape firmly to the stub-pin by placing a mass for a few seconds on the silicon 

paper (which still covers the tape). Make sure the bottom side of the mass is horizontal to 

the surface of the stub-pin. 

- Remove the silicon paper from the double sided tape using tweezers. Avoid unnecessary 

contact between the tweezers and the adhesive tape. 

- Place the stub-pin in the holder and close it to protect it from dust etc. from the environment. 

- For every new stub, repeat step 6 to 14. 
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Appendix B  
Technical drawings of stub-pin holders  

 

 
Figure 50 Holder to store 50 stub-pins, made of 8mm thick acrylate (dimensions in mm). The four holes 

at the corners were used to screw this plate to a similar plate that did not contain holes for the stub-pins, 
so the holder was closed at the bottom side. Between the plates a paper was places on which the stub 

names were displayed.   

 

 

 
Figure 51 Holder made from 8mm thick acrylate (dimensions in mm).  Used to position the stub-pin 

horizontal when the double sided tape is stuck to it, and when the tape is analysed under the 
microscope.  
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Appendix C  
List of available panty hoses at HEMA 

 
Table 4 Panty hoses available at HEMA B.V.  

Item number  Description 
(Dutch) 

Denier Colour  Material Remarks 

Polyamide 
(%) 

Elastane 
(%) 

4062500 Panty  15 black 90 10 - 

4052501 Hold-up panty 15 black 86 14 Slightly glossy 

4061204 Panty 15 black 100 0 Smooth 

4061303 Panty 20 black 95 5 Mousse  

4053404 Push-up panty 20 black 83 17  

4000041 Panty 20 black 90 10 - 

4053514 / 
4053512 

Corrigerende 
panty 

20  black 85 15 Lycra leg care 

4051679 Panty 30 black 100 0 - 

4095204 Panty 40 black 93 7 Made from recycled yarns 

4097301 Corrigerende 
panty 

40 black 93 7  

4000052 Panty 40 black 92 8 Opaque, special ‘body 
conditioning’ treatment to 
avoid sweating 

4052039 Steunpanty 40 black 82 18  

4048021 Panty opaque 50 black 87 13 Silky smooth and very 
elastic 

4000023 Corrigerende 
panty 

60 black 94 6   

4060904 Panty 60 black 87 13 Very elastic 

4000087 Panty ecocare 80 black 96 4 Made from recycled yarns 

Optional combinations to test are given the same colour: 

 The ratio between polyamide and elastane is approximately equal for these three 

panty types. The linear mass density of fibres are 15, 30 and 60 denier. 

  

 The ratio between polyamide and elastane is approximately equal for these three 
panty types. The linear mass density of fibres are 15, 20, 50 and 60 denier. 
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Appendix D   
Considerations for the substrate material choice  

 
 

 

 

Table 5 All considerations for the choice of a substrate material are summed up in this table. The main 

requirements are emphasised in bold. The colours give a quick overview of the rating of an optional 

substrate for a specific requirement: green indicates a good score, yellow a medium score and red a bad 

score.  

 
 

Fabrics Spool of threads Modified plastic 

surfaces 

Panty hoses 

R
e
la

te
d
 t

o
 t

h
e
 c

o
n
tr

ib
u
ti
o
n
 t

o
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e
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a
rc

h
 q

u
e
st

io
n
 

Good 
representation of 

samples that are 
usually stubbed? 

Yes. However, many 
more different 

textile materials are 
encountered in 

practice.  

Quite good. The 
same material as in 

real fabrics is used, 
but this substrate is 

not woven as 
usually encountered 

substrates, so the 
surface roughness is 
not influenced by 

the weaving type.  

No, a different 
material than textile 

is used. This 
material has a 

different rougness 
and different 

properties such as 
surface free energy, 
etc. Furthermore, 

milling is unsuitable 
for soft materials, 

because then the 
milling head presses 
away the material. 

Quite good, but 
panty hoses are 

made from another 
textile than cotton 

or polyester. 

Can the 
substrate be 

varied 
systematically? 

No, between 
different textiles 

more properties 
vary 

simultaneously. 

With the available 
threads this is 

possible to a certain 
extend.  

Yes, by changing 
the macroscopic 

roughness and/or 
microscopic 

roughness.  

No, between 
different textiles 

more properties 
vary 

simultaneously. 

Can different 

substrate depths 
be distinguished 
under the 

microscope? 

Yes, different depths in the substrate can be 

distinguished by the digital microscope. 

 

Yes, areas with 

different depths can 
be distinguished in 
the 2D-plane, for 

example by marking 
the different levels 

with a specific 
colour. 

Yes, depths in the 

substrate can be 
distinguished by the 
digital microscope. 

 

R
e
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d
 t

o
 t

h
e
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o
n
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st
e
n
cy

 o
f 
th

e
 

e
x
p
e
ri
m

e
n
ts

 

Can the 

substrate be 
damaged by the 

tape? 

No, not after one contact moment at least. 

Is the surface 
consistent? 

Yes, it is made by very 

accurate machines. 

Pretty good if winding 

of the threads around 
the spool is done 

consistently. 

Yes. Yes, but only when it 

is equally stretched. 

Does the 

material sink 
into the 

substrate? 

Yes. No. Yes. 

(Continued on next page) 
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(Cont’d)  Fabrics Spool of threads Modified plastic 

surfaces 

Panty hoses 

P
ra

ct
ic

a
l 
co

n
si

d
e
ra

ti
o
n
s 

Is it available or 
manufacturable? 

Available. Threads are 
available and spools 

are manufacturable.  

Manufacturable, 
but it will take a lot 

of time to 
investigate how to 

do this. 

Available. 

Is it possible for 

future research 
to obtain or 
manufacture the 

same substrate 
(i.e.: is the 

experiment 
repeatable)? 

It will be hard, or 

even impossible, to 
obtain textiles in the 
future that are equal 

to textiles bought 
for this research, 

especially when no 
manufacturer is 
known.  

Buying threads from 

the same brand with 
the same description 
is probably doable in 

the future.  

Yes, when the 

production process 
is described very 
detailed. 

It will be possible to 

find similar panties, 
but it is not 
guaranteed that the 

production of the 
specific used 

panties will be 
continued. 

Is the substrate 
reusable? 

Yes, it can be washed. This might change the material properties of the substrate, so cleaning should 
also be done before the first use.  
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Appendix E 
Procedure to produce the spools of threads 

 
1. Produce the spool bases 

- Produce the steel base according to Figure 52.  

 
Figure 52 Dimensions of the base of the spools, made from steel of 3 mm thickness (dimensions in mm). 

 
2. Warp the threads around the spool 

14. Knot the thread trough one of the holes in the base, using tweezers to get the thread 

through this hole. 

15. For every single winding, turn the metal spool (and not the threads around the spool, 

otherwise the yarns in the thread would be twined or untwined). Always keep the thread 

under tension during winding. Do not let the thread slide through your hands, for this 

would also cause untwining of the thread, but grip a new part of the thread when 

needed.  

16. Make sure that every new winding is adjacent to the previous winding. If there is a ‘gap’ 

between neighbouring windings that is visible with the naked eye), then push the 

threads together, but avoid overlapping of adjacent thread. 

 

3. Clean the substrate 

- Hold all four long edges of the spool for about 10 seconds under a warm, fast running 

water tap. Move the spool back and forth during this to make sure the water flows 

over the whole surface.  

- Dry the spool by rolling it into a disposable towel and compress it. Then dry the spool 

in the air, under room temperature for at least 12 hours, with all sides of the substrate 

free to dry. 

 

4. Name the substrates 

- The substrates should be named so these can be distinguished during the experiments. 

The names consist of the abbreviation of the thread type followed by one of the letters 

A to D, because there are 4 pieces of each substrate type, and then followed by “1-5”, 

because every substrate consists of 5 sample location. The abbreviations that are used 

for sewing polyester, extra strong sewing polyester and crochet polyester are ‘Pol.sew’, 

‘Pol.sew.str’ and ‘Pol.croch’ respectively. The location closest to the name label is sample 

location 1 and the furthest location from the label is sample location 5. 
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5. Cover the substrate to distinguish the sample locations 

- After micro-traces are deposited on the substrate the spools can be overlaid by a cover 

containing circular gaps of 14mm diameter, so that the 5 sample locations can be 

distinguished. The cover was attached to the spool at both ends by 19 mm wide 

adhesive tape. 

  

 

 
Figure 53 Dimensions of the sample cover, made from aluminium of 0.5 mm thickness (dimensions in 

mm). 

 

 The final results are depictured in Figure 54. 

 

 
Figure 54 Resulting textile samples. 
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Appendix F 
Calculation of the concentration of microspheres in the 

suspension  
 

 
The number of particles per gram is 9.2E4 particles/mg [9].  

 

Needed particles per sample circle  

Desired number of particles in Ø10 mm circle 𝟏𝟎𝟎𝟎 

Surface area Ø10 mm circle 𝟕𝟖. 𝟓𝟒 𝒎𝒎𝟐 

Surface area of material deposition (including area 

around circle: 16x16mm) 
𝟐𝟓𝟔 𝒎𝒎𝟐 

Desired number of particles on 16x16mm surface 
256

78.54
⋅ 1000 = 𝟑𝟐𝟓𝟗 

Needed weight of microspheres per sampled area 
3259

9.2 ⋅ 104/𝑚𝑔
= 𝟑. 𝟓𝟒 ⋅ 𝟏𝟎−𝟐 𝒎𝒈 

  

Needed volume of ethanol per sample circle  

Desired number of droplets for textiles 𝟒 

Desired number of droplets for glass 𝟐 

Volume of one droplet  𝟎. 𝟎𝟐𝟓 𝒎𝑳 

Total volume of ethanol for textile per sample  𝟎. 𝟏 𝒎𝑳 

Total volume of ethanol for glass 𝟎. 𝟎𝟓 𝒎𝑳 

 

For textile substrates: concentration of   
3.54⋅10−2 mg

0.1 𝑚𝐿
= 0.354 𝑚𝑔/𝑚𝐿 

 

For glass substrates: concentration of 
3.54⋅10−2 mg

0.05 𝑚𝐿
= 0.708 𝑚𝑔/𝑚𝐿 
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Appendix G   
Measured diameters of the used textile threads 

 
Table 6 Measured thread diameters and the calculated mean diameter of the threads. The threads were 
measured as represented in Figure 55. 

 Thread diameter [mm] 

Measurement Crochet Polyester Sewing polyester 
Extra strong 

sewing polyester 

1 1.006 0.217 0.373 

2 1.221 0.214 0.407 

3 1.115 0.205 0.392 

4 1.206 0.209 0.336 

5 1.113 0.202 0.316 

6 1.248 0.202 0.336 

7 0.873 0.198 0.340 

8 1.077 0.222 0.316 

9 1.030 0.253 0.370 

10 1.175 0.238 0.342 

Mean: 1.132 0.216 0.353 

 
Crochet Polyester 

 
Extra strong sewing polyester 

 
Sewing polyester  

 
Figure 55 Some examples of the measured thread diameters for crochet polyester, extra strong sewing 

polyester and sewing polyester.  

[8] 1077µm 

[7] 340µm 

[8] 316µm 

[2] 214µm 
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Appendix H 
Graphs of the substrate impression versus the stubbing 

force 
  

 

 
Figure 56 Measured impression on the substrates under an applied stubbing force (including the system’s 

deformation). The different line types indicate the three different sample circles where the data was 
measured (circle 1: ___ , circle 4: _ _ _ , circle 3: … ), see Figure 20. 

  



Appendix I 

64 

 

Appendix I 
Photoshop editing procedure 

A ‘Droplet’ was created in Photoshop. In this application, images could be dragged and dropped 
to be edited according to the actions that are embedded in the Droplet. Hereby, a lot of images 

can be edited in the same way very fast and easily.  
 
A droplet can be created as follows: 

- Select “New Action” in the Action panel menu (if this is not visible, click on: “Window” 

> “Actions”) 

- Name your action and click “Record” 

- Execute the actions that should be embedded in the droplet (see descriptions below) 

- Click on: “File” > “Automate” > “Create Droplet”.  

o Select the name of your action.  

o Choose the file destination of the new Droplet and the files that will be created 

by this Droplet. 

o Define the document name of the edited picture as “Document name + _PS + 

extension” 

 
 

Actions to edit images of the textile substrate: 

 Image > Adjustments > Invert 

 Image > Adjustments > Hue/Saturation 

Cyans: Saturation +80% 

 Image > Adjustments > Selective color 

Reds, Yellows, Greens, Magentas, Whites and Neutrals: black +100% (absolute) 

 Image > Adjustments > Threshold 

All channels: Threshold Level: 40 

 Image > Adjustments > Black & White 

(Default settings) 

 Save  

(Maximal quality) 

 

Actions to edit images of the tape: 

 Image > Adjustments > Invert 

 Image > Adjustments > Hue/Saturation 

Cyans: Saturation +100%  

 Image > Adjustments > Selective color 

Reds, Yellows, Greens, Magentas, Whites and Neutrals: black +100% (absolute) 

 Image > Adjustments > Threshold 

All channels: Threshold Level: 55 

 Image > Adjustments > Black & White 

(Standard settings) 

 Save  

(Maximal quality) 
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Actions to edit images of the glass substrates: 

 Image > Adjustments > Invert 

 Image > Adjustments > Brightness/Contrast 

Brightness: +100% 

 Image > Adjustments > Hue/Saturation 

Cyans: Saturation +100%  

 Image > Adjustments > Selective color 

Reds, Yellows, Greens, Magentas, Whites and Neutrals: black +100% (absolute) 

 Image > Adjustments > Threshold 

All channels: Threshold Level: 55 

 Image > Adjustments > Black & White 

(Standard settings) 

 Save 

(Maximal quality) 

 

(!) Caution: the Droplet overwrites the original file, so always use a copy of your original file in 

the Droplet! 
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Appendix J 
MATLAB files  

 
 

Read_data.m This function was used to read data from the 
tensile tester. 

p. 67 

Run_define_particle_nr_substrates.m 

 

This code was used to calculate the number of 
detected microspheres on the substrates 
before stubbing by calling the function 
Define_particle_nr.m 

p. 68 

Run_define_particle_nr_stubs.m This code was used to calculate the number of 
detected microspheres on the tape after 
stubbing by calling the function 
Define_particle_nr.m 

p. 69 

Define_particle_nr.m 

 

This function was used to calculate the number 
of detected microspheres in an image by first 
masking and editing the image. 

p. 70 

Run_define_particle_height_textiles.m 

 

This code was used to determine the height of 
detected microspheres on a textile before and 
after stubbing by calling 
Define_particle_height_textiles.m. 

 

p. 72 

Define_particle_height_textiles.m 

 

This function was used to determine the height 
of detected microspheres by overlapping the 
normal image and the resized height profile of 
the image. 

p. 74 
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Read_data.m 

   

function [x,F,max_error_F] = read_data(data_material,material) 

t = data_material(:,1);     % Time [s] 

x = -data_material(:,2);    % Displacement of the crosshead from start position [mm] 

F = data_material(:,3);     % Force measured by the load cell [N] 

  

% Variables to process the data 

lower_limit_F = 0.005;  % The data is cut off if the foce comes below this value, 

                        % for this small measured forces can be a result of noise [N] 

upper_limit_F = 9;      % After this contact force was reached, the stub moved back  

                        % from the substrate again [N] 

smooth_span = 600;      % Data is smoothened using the average of this number of points 

  

if material(1:2) == 'SN' 

    smooth_upper_limit = 0.005; % Up to this force the graph is smoothened [N] 

elseif material(1:2) == 'ST'    

    smooth_upper_limit = 0.02; % Up to this force the graph is smoothened [N] 

else 

    smooth_upper_limit = 0.05; % Up to this force the graph is smoothened [N] 

end 

_______________________________________________________________________________________ 

%% Smooth Force data 

% Define the indexes of forces below the smooth upper limit: 

for k = 1:1:length(F) 

    if F(k)> smooth_upper_limit 

        break 

    end 

end 

index_Fsmooth_lim = k; 

  

Fsmooth1 = smooth(F(1:index_Fsmooth_lim),smooth_span);  

Fsmooth = [Fsmooth1; F(index_Fsmooth_lim+1:end)];  

  

errors = abs(F-Fsmooth); 

[max_error_F,i_max_error] = max(errors); 

  

Fold = F;  

F = Fsmooth; 

_______________________________________________________________________________________ 

%% Delete data that was obtained after maximum force was reached 

for i = 1:1:length(F) 

    if F(i)> upper_limit_F 

        break 

    else 

        i = length(F); 

    end 

end 

index_Fmax = i; 

  

x = x(1:index_Fmax); 

F = F(1:index_Fmax); 

_______________________________________________________________________________________ 

%% Delete data that was obtained before contact was made between the tape and the 

substrate 

% Only include data that is reached after the lower limit is definitely passed: 

for j = length(F):-1:1 

    if  F(j) < lower_limit_F  

        break 

    else 

        j = 1; 

    end 

end 

  

index_x0 = j+1; 

val_x0 = x(index_x0); 

x = x(index_x0:end)-val_x0; 

F = F(index_x0:end); 

end 
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Run_define_particle_nr_substrates.m 

 

%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%% 

%%% Define the number of detected microspheres                   %%% 

%%% on the substrates before stubbing                            %%% 

%%%    By Selma Damsteeg - van Berkel     2016                   %%% 

%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%% 

clear all; clc; close all; 

_______________________________________________________________________________________

%% Paths to images and matlabfiles: 

addpath('G:\Keyence_microscope\20160809_prestub'); 

addpath('G:\Keyence_microscope\20160809_prestub_PS'); 

addpath('C:\Users\Selma\Documents\Graduation'); 

_______________________________________________________________________________________

%% Particle density on textile substrates  

% Set variables: 

R_spheres_textile = [8 13];     % Range of microsphere radius [px] 

range_R_textile = [6000 6300];  % Range of the sample circle radius [px] 

R_textile = 6200-550;           % Radius of analysed area of the sample circle [px] 

polarity_textile = 'dark';      % Setting for finding the sample circle with  

    'imfindcircle' 

sens_textile = 0.97;            % Detection sensitivity of microspheres in  

    'imfindcircle' 

tol_overlap_textile = 3;        % Tolerated overlap of detected microspheres [px] 

nr_bwareaopen_textile = 40;     % Setting used to remove noise in the Photoshop image  

    with the function 'bwareaopen' 

  

[num_xls,text_xls]=xlsread('DATA_EXPERIMENTS.xlsx');  

textile_names = char(text_xls(28:33,2));    % Polcroch 

% textile_names = char(text_xls(34+5:48,2));    % Polsew 

% textile_names = char(text_xls(49+3:63,2));  % Polsewstr 

  

% % (!) For Polsew, some settings are different than for Polcroch and Polsewstr: 

% R_spheres_textile = [7 13];     

% sens_textile = 0.945;  

% nr_bwareaopen_textile = 100; 

 

% Calculate particle density by using 'Define_particle_nr.m': 

particle_nrs = []; 

for i = 1:length(textile_names(:,1)) 

    name = textile_names(i,:); 

image_prestub = imread([name '_prestub_normal.jpg']); % Image of the substrate 

[H,W,RGB] 

PS_image_prestub = imread([name '_prestub_normal_PS.jpg']); % Image edited by Photoshop  

name_prestub = [name ' before stubbing']; 

[particle_nr,centers_prestub,radii_prestub] = ... 

    Define_particle_nr(image_prestub,PS_image_prestub,range_R_textile,R_textile,... 

    polarity_textile,R_spheres_textile,sens_textile,tol_overlap_textile,... 

    nr_bwareaopen_textile,name_prestub); 

  

particle_nrs = [particle_nrs; particle_nr]; 

end  

_______________________________________________________________________________________ 

%% Particle density on glass substrates 

% % Set variables: 

% R_spheres_glass = [5 8];        % Range of microsphere radius [px] 

% range_R_glass = [6000 6300];    % Range of the sample circle radius [px] 

% R_glass = 6200 - 550;           % Radius of analysed area of the sample circle [px] 

% polarity_glass = 'dark';        % Setting for finding the sample circle with  

      'imfindcircle' 

% sens_glass = 0.975;             % Detection sensitivity of microspheres in  

             'imfindcircle' 

% tol_overlap_glass = 8;          % Tolerated overlap of detected microspheres [px] 

% nr_bwareaopen_glass = 40;       % Setting used to remove noise in the Photoshop image  

          with the function 'bwareaopen' 

%  

% glass_names = ['GlassA1'; 'GlassA2'; 'GlassA3'; 'GlassB2';   

%                'GlassC1'; 'GlassC2'; 'GlassC3'; 'GlassD1'; 'GlassD2'; 'GlassD3'; 

%                'GlassE1'; 'GlassE2'; 'GlassE3'; 'GlassF1'; 'GlassF2'; 'GlassF3']; 

%  

% % Calculate particle density by using 'Define_particle_nr.m' 

% particle_nrs = []; 

% for i = 1:length(glass_names(:,1)) 

%     name = glass_names(i,:); 

%  

% image_prestub = imread([name '_prestub.jpg']); % Image of the substrate [H,W,RGB]  
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Run_define_particle_nr_stubs.m 

  

% PS_image_prestub = imread([name '_prestub_PS.jpg']); % Image edited by Photoshop  

% name_prestub = [name ' before stubbing']; 

% [particle_nr,centers_prestub,radii_prestub] = ... 

%     Define_particle_nr(image_prestub,PS_image_prestub,range_R_glass,R_glass,... 

%     polarity_glass,R_spheres_glass,sens_glass,tol_overlap_glass,... 

%     nr_bwareaopen_glass,name_prestub); 

%  

% particle_nrs = [particle_nrs; particle_nr]; 

% end 

 

 

%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%% 

%%% Define the number of detected particles on the stub tapes    %%% 

%%%    By Selma Damsteeg - van Berkel     2016                   %%% 

%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%% 

clear all; clc; close all; 

  

% Paths to images and matlabfiles: 

addpath('G:\Keyence_microscope\20160816_stubbed');  

addpath('G:\Keyence_microscope\20160816_stubbed_PS'); 

addpath('C:\Users\Selma\Documents\Graduation\Matlab\Particle count');   

addpath('C:\Users\Selma\Documents\Graduation'); 

  

% Set variables: 

R_spheres_tape = [9 13];    % Range of microsphere radius [px]  

range_R_tape = [4300 4700]; % Range of the tape radius [px]      

R_tape = 4400;              % Radius of analysed area of the tape (no edges) [px] 

polarity_tape = 'bright';   % Setting used for finding the round tape with  

'imfindcircle' 

sens_tape = 0.975;          % Detection sensitivity of microspheres in 'imfindcircle' 

tol_overlap_tape = 8;       % Tolerated overlap of detected microspheres[px] 

nr_bwareaopen_tape = 40;    % Setting used to remove noise in the Photoshop image with  

the function 'bwareaopen' 

  

[num_xls,text_xls]=xlsread('DATA_EXPERIMENTS.xlsx');  

tape_names = char(text_xls(2:18,3)); 

_______________________________________________________________________________________

%% Particle number on stubs 

nrs_tape = []; 

for i = 1:length(tape_names(:,1)) 

    name_tape = tape_names(i,:); 

    image_tape = imread([name_tape '.jpg']); 

    PS_image_tape = imread([name_tape '_PS.jpg']); 

    [nr_tape,centers_tape,radii_tape] = ... 

        Define_particle_nr(image_tape,PS_image_tape,range_R_tape,R_tape,... 

        polarity_tape,R_spheres_tape,sens_tape,tol_overlap_tape,... 

        nr_bwareaopen_tape, name_tape); 

    nrs_tape = [nrs_tape;nr_tape];          

end 
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Define_particle_nr.m 

 

function [particle_nr,true_centers,true_radii] = ... 

    Define_particle_nr(image,PS_image,range_Rsample,R_sample,... 

    polarity_sample,R_spheres,sensitivity,tolerance_overlap,nr_bwareaopen,name) 

 

H = length (PS_image(:,1,1));    

W = length(PS_image(1,:,1));        % Size of picture 

downscale = 0.1; 

scaled_image = imresize(image,downscale); 

_______________________________________________________________________________________

%% Detect sample area using the normal picture 

if name(1:7) == 'stub2B5' 

    % Change the RGB picture to a black-white picture, so the tape can be detected 

    adj_level = 0.5; 

    scaled_image_adj = im2bw(scaled_image,adj_level);   

elseif name(1:7) == 'stub1F5' 

    adj_level = 0.5; 

    scaled_image_adj = im2bw(scaled_image,adj_level); 

elseif name(1:5) == 'Glass' 

    adj_level = 0.5; 

    scaled_image_adj = im2bw(scaled_image,adj_level); 

else 

    % For all other pictures: change the RGB picture to a grayscale picture 

    scaled_image_adj = rgb2gray(scaled_image);   

end 

  

[center_sample_scaled, radius_sample_scaled] = ... 

    imfindcircles(scaled_image_adj,downscale*range_Rsample,'ObjectPolarity',... 

    polarity_sample, 'Sensitivity',0.995);  

center_sample_scaled = round(center_sample_scaled); % (x_center y_center) 

  

% Check if exactly 1 circle is found: 

if length(center_sample_scaled(:,1)) < 1    

    disp('Error! No sample circle is detected in the image.') 

    return 

elseif length(center_sample_scaled(:,1)) == 1 

    disp('A sample circle is detected in the image.')    

elseif length(center_sample_scaled(:,1)) > 1  

    disp('More than one sample circle is detected in the image. (The circle with the 

highets circle strength is used.)')    

end 

  

% Scale back to real scale: 

center_sample = center_sample_scaled(1,:)./downscale; 

radius_sample = R_sample; 

_______________________________________________________________________________________

%% Mask PS_image 

% Create mask: 

[xx,yy] = ndgrid((1:W)-center_sample(1),(1:H)-center_sample(2)); 

mask_sample = uint8((xx.^2 + yy.^2) < radius_sample^2); 

mask_sample = mask_sample.'; % Invert the mask to change x,y to y,x, so this 

corresponds with (height,width) 

  

% Apply mask to images: 

final_PS_image = mask_image(mask_sample,PS_image); 

_______________________________________________________________________________________

%% Find location of microspheres in the Photoshop image  

% Use image operations to make the PS image more suitable for detection of microspheres 

% Change image to a BW image to enable the other operations: 

final_PS_image = im2bw(final_PS_image);  

% Changes black (0-valued) pixels to white (1-valued) pixels if they have 

% two white neighbors that are not connected: 

BW_PS_image = bwmorph(final_PS_image,'bridge');  

% Apply erosion followed by a dilation, using the same structuring element: 

se = [0 1 0 ;1 1 1]; % Structuring element neighbourhood 

BW_PS_image = imopen(BW_PS_image,se);  

% Remove all connected components(white objects) that have fewer than P pixels: 

BW_PS_image = bwareaopen(BW_PS_image,nr_bwareaopen);  

% Find the location of the microspheres: 

[centersBW, radiiBW] = imfindcircles(BW_PS_image,R_spheres,'ObjectPolarity','bright', 

'Sensitivity',sensitivity); 

 % Remove overlapping circles, for these are (mostly) an incorrect representation of 

the microspheres: 

[centers,radii]=RemoveOverLap(centersBW,radiiBW,tolerance_overlap,1); 
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centers = round(centers);                    

radii = round(radii); 

_______________________________________________________________________________________

%% All found circles outside the mask area should be deleted! 

% Even though the image is masked, circles are falsely detected on the outer edge of 

% the masked area. Obviously,  these circles have to be removed. 

i_centers = []; 

for i = 1:length(centers(:,1)) 

    if mask_sample(centers(i,2),centers(i,1)) == 1 

        i_centers = [i_centers; i]; 

    end 

end 

  

true_centers = centers(i_centers,:); 

true_radii = radii(i_centers,:); 

  

particle_nr = length(true_centers(:,1)); % Total nr. of detected particles 

_______________________________________________________________________________________

%% Show image with microspheres 

figure 

imshow(image) 

% hold on; viscircles(centersBW,radiiBW,'edgeCOlor','b'); 

hold on; viscircles(true_centers,true_radii,'edgeCOlor','r'); 

hold on; viscircles(center_sample,radius_sample,'edgeCOlor','b'); 

title([num2str(particle_nr) ' detected microspheres on ' name]) 

saveas(gcf,['G:\Keyence_microscope\Particles_detected \' name],'fig')     

saveas(gcf,['G:\Keyence_microscope\Particles_detected\' name],'png')     

  

end 
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Run_define_particle_height_textiles.m 

 

%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%% 

%%% Define the height of the particles in the textile structures %%% 

%%% before and after stubbing                                    %%% 

%%%    By Selma Damsteeg - van Berkel     2016                   %%% 

%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%% 

clear all; clc; close all; 

_______________________________________________________________________________________ 

%% Paths to images and matlabfiles: 

addpath('G:\Keyence_microscope\20160809_prestub'); 

addpath('G:\Keyence_microscope\20160809_prestub_PS'); 

addpath('G:\Keyence_microscope\20160816_stubbed');  

addpath('G:\Keyence_microscope\20160816_stubbed_PS'); 

load('C:\Users\Selma\Documents\Graduation\Matlab\Particle count\height_max') 

_______________________________________________________________________________________

%% Set variables: 

R_spheres_textile = [8 13];     % Range of microsphere radius [px] 

range_R_textile = [6000 6300];  % Range of the sample circle radius [px]       

R_textile = 3150;               % Radius of the area that was fully covered by tape 

[px] 

polarity_textile = 'dark';      % Setting used for finding the round tape with the  

    fuction 'imfindcircle' 

sens_textile = 0.97;            % Detection sensitivity of microspheres in the fuction  

    'imfindcircle' 

tol_overlap_textile = 3;        % Tolerated overlap of detected microspheres[px] 

nr_bwareaopen_textile = 40;     % Setting used to remove noise in the Photoshop image  

    with the function 'bwareaopen' 

  

textile_names =['PolcrochA1 ';'PolcrochA2 ';'PolcrochA3 ';'PolcrochA4 ';'PolcrochA5 '; 

               'PolcrochB1 ';'PolcrochB3 ';'PolcrochB4 '; 

               'PolcrochC1 ';'PolcrochC2 ';'PolcrochC3 ';'PolcrochC5 ';'PolcrochD1 '; 

               'PolsewstrA1';'PolsewstrA2';'PolsewstrA3';'PolsewstrA4';'PolsewstrA5'; 

               'PolsewstrB1';'PolsewstrB2';'PolsewstrB3';'PolsewstrB4';'PolsewstrB5'; 

               'PolsewstrC1';'PolsewstrC2';'PolsewstrC3';'PolsewstrC4';'PolsewstrC5']; 

            

% % (!) For Polsew, some settings are different than for Polcroch and Polsewstr: 

% R_spheres_textile = [7 13];     

% sens_textile = 0.945;  

% nr_bwareaopen_textile = 100; 

%  

% textile_names=['PolsewA1   ';'PolsewA2   ';'PolsewA3   ';'PolsewA4   ';'PolsewA5   '; 

%               'PolsewB1   ';'PolsewB2   ';'PolsewB3   ';'PolsewB4   ';'PolsewB5   '; 

%               'PolsewC2   ';'PolsewC3   ';'PolsewC4   ';'PolsewC5   ';'PolsewD1   ']; 

  

for i = 1:length(textile_names(:,1)) 

    name = strtok(textile_names(i,:)); 

_______________________________________________________________________________________

%% Before stubbing 

image_prestub = imread([name '_prestub_normal.jpg']); % Original image [H,B,RGB] 

PS_image_prestub = imread([name '_prestub_normal_PS.jpg']); % Image edited by Photoshop  

height_prestub = imread([name '_prestub_height.jpg']);      % Height profile image  

 

height_prestub_max = eval(['height_max.' name '_prestub']); 

refheight_prestub = imread([name '_prestub_refheight.jpg']);% Image with the same size 

as the height profile, needed to detect the sample circle in height properly  

name_prestub = [name ' before stubbing']; 

    if name_prestub(1:10) == 'PolcrochA3' % (This image deviated from others) 

    scale_PCA3 = 4642/6200; 

    image_prestub = imresize(image_prestub,1/scale_PCA3); 

    PS_image_prestub = imresize(PS_image_prestub,1/scale_PCA3); 

    end 

  

[final_height_prestub,final_image_prestub,nr_prestub,height_centers_prestub,... 

 centers_prestub,radii_prestub,height_zero_prestub] = ... 

    Define_particle_height_textiles(image_prestub,PS_image_prestub,height_prestub,... 

    refheight_prestub,range_R_textile,R_textile,R_spheres_textile,sens_textile,... 

    tol_overlap_textile,nr_bwareaopen_textile,name_prestub,height_prestub_max); 

_______________________________________________________________________________________

%% After stubbing 

image_stubbed = imread([name '_stubbed_normal.jpg']); 

PS_image_stubbed = imread([name '_stubbed_normal_PS.jpg']); 

height_stubbed = imread([name '_stubbed_height.jpg']);      % Height profile image 

(information about roughness of the substrate) 

height_stubbed_max = eval(['height_max.' name '_stubbed']); 
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refheight_stubbed = imread([name '_stubbed_refheight.jpg']);% Image with the same size 

as the height profile, needed to detect the sample circle in height properly  

name_stubbed = [name ' after stubbing']; 

  

[final_height_stubbed,final_image_stubbed,nr_stubbed,height_centers_stubbed,... 

 centers_stubbed,radii_stubbed,height_zero_stubbed] = ... 

    Define_particle_height_textiles(image_stubbed,PS_image_stubbed,height_stubbed,... 

    refheight_stubbed,range_R_textile,R_textile, R_spheres_textile, sens_textile,... 

    tol_overlap_textile,nr_bwareaopen_textile,name_stubbed,height_stubbed_max); 

_______________________________________________________________________________________ 

%% Figures 

figure 

subplot(2,2,1) 

imshow(final_image_prestub); 

hold on; viscircles(centers_prestub,radii_prestub, 'edgeColor','r'); 

title([num2str(nr_prestub) ' detected microspheres on ' name_prestub]) 

hold on 

subplot(2,2,2) 

imshow(final_height_prestub); 

hold on; viscircles(centers_prestub,radii_prestub, 'edgeColor','r'); 

subplot(2,2,3) 

imshow(final_image_stubbed); 

hold on; viscircles(centers_stubbed,radii_stubbed, 'edgeColor','r'); 

title([num2str(nr_stubbed) ' detected microspheres on ' name_stubbed]) 

hold on 

subplot(2,2,4) 

imshow(final_height_stubbed); 

hold on; viscircles(centers_stubbed,radii_stubbed, 'edgeColor','r'); 

AX = findall(gcf,'Type','axes'); 

linkaxes(AX,'xy') 

_______________________________________________________________________________________

%% Save data for histograms 

saveas(gcf,['C:\Users\Selma\Documents\Graduation\Matlab\Particle 

count\Height_particles\Height_particles_' name],'fig') 

  

save(['C:\Users\Selma\Documents\Graduation\Matlab\Particle 

count\Height_particles\h_prestub_' name '.mat'],'height_centers_prestub') 

save(['C:\Users\Selma\Documents\Graduation\Matlab\Particle 

count\Height_particles\h_zero_prestub_' name '.mat'],'height_zero_prestub') 

  

save(['C:\Users\Selma\Documents\Graduation\Matlab\Particle 

count\Height_particles\h_stubbed_' name '.mat'],'height_centers_stubbed') 

save(['C:\Users\Selma\Documents\Graduation\Matlab\Particle 

count\Height_particles\h_zero_stubbed_' name '.mat'],'height_zero_stubbed') 

  

end 
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Define_particle_height_textiles.m 

function [final_height,final_image,particle_nr,... 

height_centers_rel,centers,radii,height_zero] = ... 

    Define_particle_height_textiles(image,PS_image,height,refheight,range_Rsample,... 

    R_sample,range_Rspheres,sensitivity,tolerance_overlap,nr_bwareaopen,name,... 

    height_max)  

_______________________________________________________________________________________

%% Dimensions of images 

H = length (PS_image(:,1,1));   % Height of the normal picture [px]    

W = length(PS_image(1,:,1));    % Width of the normal picture [px] 

Hh = length(height(:,1,1));     % Height of the height profile image [px] 

Wh = length(height(1,:,1));     % Width of the height profile image [px] 

  

% The normal image should be scaled down, so the sample circle can be  

% detected by using imfindcircles: 

downscale = 0.1;  

scaled_image = imresize(image,downscale); 

_______________________________________________________________________________________

%% Detect sample circle in Photoshop image (using the normal image) 

scaled_image_gray = rgb2gray(scaled_image);  % Change RGB picture to grayscale picture 

[center_sample_PS_scaled, radius_sample_PS_scaled] = ... 

imfindcircles(scaled_image_gray,downscale*range_Rsample, ... 

'ObjectPolarity','dark','Sensitivity',0.999);  

center_sample_PS_scaled = round(center_sample_PS_scaled); % (x_center y_center) [px] 

  

% Check if exactly 1 circle is found: 

if length(radius_sample_PS_scaled) < 1    

    disp('Error! No sample circle is detected in the picture.') 

    return 

elseif length(radius_sample_PS_scaled) == 1 

    disp('A sample circle is detected in the picture.') 

elseif length(radius_sample_PS_scaled) > 1  

    disp('More than one sample circle is detected in the image. (The circle with the  

          highets circle strength is used.)')    

end 

  

% Scale coordinates back to normal picture size and, if more than one circle is  

% detected, select the circle with the highest circle strength: 

center_sample_PS = center_sample_PS_scaled(1,:)./downscale; 

radius_sample_PS = R_sample; 

_______________________________________________________________________________________

%% Mask Photoshop image and normal image 

% Create mask: 

[xx,yy] = ndgrid((1:W)-center_sample_PS(1),(1:H)-center_sample_PS(2)); 

mask_PS = uint8((xx.^2 + yy.^2) < radius_sample_PS^2); 

mask_PS = mask_PS.'; 

  

% Apply mask to images: 

masked_PS_image = mask_image(mask_PS,PS_image); 

masked_image = mask_image(mask_PS,image); 

_______________________________________________________________________________________

%% Detect sample area in the height profile (using the reference picture) 

adj_level = 0.9; 

refheight_adj = im2bw(refheight,adj_level);  % Change the RGB picture to a blackwhite 

picture, so the sample circle can be detected. 

[center_sample_hp, radius_sample_hp] = imfindcircles(refheight_adj,[400 

500],'ObjectPolarity','dark', 'Sensitivity',0.99); 

  

% Check if exactly 1 circle is found: 

if length(radius_sample_hp) < 1    

    disp('Error! No sample circle is detected in the height profile.') 

    return 

elseif length(radius_sample_hp) == 1 

    disp('A sample circle is detected in the height profile.') 

elseif length(radius_sample_hp) > 1  

    disp('More than one sample circle is detected in the image. (The circle with the 

highets circle strength is used.)')    

end 

% If more than one circle is detected, choose the circle with the highest circle 

strength: 

center_sample_hp = round(center_sample_hp(1,:)); % (x_center y_center) [px] 

% radius_sample_hp = round(radius_sample_hp(1)); % [px] 

scale = 905/max(H,W); % In the height profile, the image fits in a box of 905x905 

pixels 
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radius_sample_hp = scale*radius_sample_PS;      % The radius of the sample circle is 

kept constant. The number  0.0681 is based on measurements: (D_hp/D_normal) 

_______________________________________________________________________________________

%% Mask height profile 

% Create mask: 

[xx,yy] = ndgrid((1:Wh)-center_sample_hp(1),(1:Hh)-center_sample_hp(2)); 

mask_height = uint8((xx.^2 + yy.^2) < radius_sample_hp^2); 

mask_height = mask_height.'; 

  

% Apply mask to image: 

masked_height = mask_image(mask_height,height);    

% Recolour the black mask into red (needed for defining the minimum height) 

masked_height(masked_height(:,:,1)==0 & masked_height(:,:,2)==0 & 

masked_height(:,:,3)==0) = 255; 

_______________________________________________________________________________________

%% Scale values of height profile to Photoshop image 

center_sample_hp = center_sample_hp.*(1/scale); 

radius_sample_hp = radius_sample_hp*(1/scale);   

refheight = imresize(refheight,(1/scale)); 

masked_height = imresize(masked_height,(1/scale)); 

Wh = Wh*(1/scale); 

Hh = Hh*(1/scale); 

_______________________________________________________________________________________

%% Cut images to the circle to make them equally sized 

final_PS_image = masked_PS_image(... 

center_sample_PS(2)-radius_sample_PS : center_sample_PS(2)+radius_sample_PS,... 

center_sample_PS(1)-radius_sample_PS : center_sample_PS(1)+radius_sample_PS,:); 

final_image = masked_image( ... 

center_sample_PS(2)-radius_sample_PS : center_sample_PS(2)+radius_sample_PS,... 

center_sample_PS(1)-radius_sample_PS : center_sample_PS(1)+radius_sample_PS,:);     

final_height =  masked_height(... 

center_sample_hp(2)-radius_sample_hp : center_sample_hp(2)+radius_sample_hp,... 

center_sample_hp(1)-radius_sample_hp : center_sample_hp(1)+radius_sample_hp,:);       

_______________________________________________________________________________________

%% Show masked and cut images 

figure 

subplot(2,2,1); imshow(image) 

hold on; viscircles(center_sample_PS,radius_sample_PS, 'edgeColor','b'); 

title(['Detect sample area in image of ' name]); hold on 

subplot(2,2,2); imshow(final_PS_image) 

title('Masked and cut PS image'); hold on 

subplot(2,2,3); imshow(refheight) 

hold on; viscircles(center_sample_hp,radius_sample_hp, 'edgeColor','b'); 

title('Detect sample area in refheight'); hold on 

subplot(2,2,4); imshow(final_height) 

title('Masked, resized and cut heightprofile') 

_______________________________________________________________________________________

%% Find location of microspheres in the Photoshop image  

% Use image operations to make the Photoshop image more suitable for detection of the 

microspheres 

% Change image to a BW image to enable the other operations: 

final_PS_image = im2bw(final_PS_image);  

% Changes black (0-valued) pixels to white (1-valued) pixels if they have 

% two white neighbors that are not connected: 

BW_PS_image = bwmorph(final_PS_image,'bridge');  

% Apply erosion followed by a dilation, using the same structuring element: 

se = [0 1 0 ;1 1 1]; % Structuring element neighbourhood 

BW_PS_image = imopen(BW_PS_image,se);  

% Remove all connected components(white objects) that have fewer than P pixels: 

BW_PS_image = bwareaopen(BW_PS_image,nr_bwareaopen);  

  

% Find the location of the microspheres: 

[centersBW, radiiBW] = ... 

imfindcircles(BW_PS_image,range_Rspheres,'ObjectPolarity','bright', ... 

'Sensitivity',sensitivity); 

  

% Remove overlapping circles, for these are (mostly) an incorrect representation of the 

microspheres:  

[centers,radii]=RemoveOverLap(centersBW,radiiBW,tolerance_overlap,1); 

centers = round(centers); 

radii = round(radii);  

particle_nr = length(centers(:,1)); % Total nr. of detected particles 

_______________________________________________________________________________________

%% Interpret colours in height profile 

% Load the RGB values of the legend colour bar (which are read from the colour bar 

automatically in 'Check_height.m') 



Appendix J 

76 

 

 
 

 

  

load('C:\Users\Selma\Documents\Graduation\Matlab\Particle count\RGB_values')     

% Define the heights related to the colours in the legend colour bar. Therefore, 

% calculate the height difference between sequential colours in the colour bar 

% (height_max is the maximum height in the legend [um]):  

heightdiff_colordiff = height_max/length(RGB_values(:,1)); % [um] 

% Define heights values [um] that correspond to the colours in the legend: 

height_values = []; 

for i = length(RGB_values(:,1))+1:-1:1 

    height_value = heightdiff_colordiff*length(RGB_values(1:i-1,1)); 

    height_values = [height_values; height_value]; 

end 

_______________________________________________________________________________________

%% Find the absolute height in the substrate structure of each microsphere (center) 

height_centers_abs = []; 

for k = 1:length(centers) 

i = centers(k,2); 

j = centers(k,1); 

    % Find RGB value in final_height image of the pixel at the k'th center: 

    RGB_center = double(final_height(i,j,:));  

    % Check the index of the best matching colour in the colour bar: 

    [Y,indexRGB] = min(abs(RGB_center(1)-RGB_values(:,1)) + ... 

        abs(RGB_center(2)-RGB_values(:,2)) + abs(RGB_center(3)-RGB_values(:,3)));    

    % Use this index to find the height that corresponds to the colour of the center: 

    height_center_abs = height_values(indexRGB); % [um] 

    % Put all heights together in a vector: 

    height_centers_abs = [height_centers_abs; height_center_abs]; 

end 

_______________________________________________________________________________________

%% Define the relative height in the substrate structure of each microsphere (center) 

% Correct the center heights by subtracting the minimal height detected in the sample  

% circle (this isn't always zero, because the incorrect height values detected on the  

% sample cover can be zero!)The minimal height can be found by finding the pixel with  

% the minimum sum of the Red and Green value: 

%     (!) This is only valid if min. height is indicated by a colour between  

%     dark blue [0 41 228] and yellow [0 251 252].    

lower_lim_RG = min(min(final_height(:,:,1)+final_height(:,:,2))); % Minimum of the sum  

of Red and Green values of one pixel.) 

lower_lim_RG = double(lower_lim_RG); 

% Find Red and Green values in the legend closest to the found values: 

diff_lower_lim_RG = (RGB_values(:,1)+RGB_values(:,2)) - lower_lim_RG;     

[val, index_RGB_lower_lim] = min(diff_lower_lim_RG);    

% Use this index to find the minimum height in the sample:   

height_zero = height_values(index_RGB_lower_lim);  % [um]                     

  

% Calculate the height of the centers relative to the minimum height that was found in 

the sample:  

height_centers_rel = height_centers_abs - height_zero; % [um]                       

  

end 
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Appendix K 
Determination of the substrate area that was fully 

covered by tape  

To analyse the particle distribution over the height of the textile substrates (before and after 

stubbing), only the circle was analysed that was fully covered by the tape anyhow. This circle, 
centred in the sample circle, was determined by assuming the ‘worst-case scenario’, in which 

the tape could have been placed most far from the centre of the substrate, see Figure 57. The 
radius of the circle that was fully covered by tape, even in this situation, was calculated by using 

Figure 58. The radius turned out to be 3150 pixels in the microscope image, see equation K.1. 

 
 

 
 

  
Figure 57 The tape could have been placed most far from the centre of the substrate if the stub was 

placed on the substrate directly against the substrate cover, and the stub was used for which the 
distance between tape and the edge of the stub was the shortest (which was true for stub 1G3, with 

about 0.59 mm (550 pixels) between the tape and the edge of the stub). 

 

Figure 58 The white circle indicates the region centred in the sample circle that was fully covered by tape 
during every tape-lift. The dimensions are expressed in the number of pixels in the microscope image. 

The sample circle had a radius of 6200 pixels and the tape had a radius of 4400 pixels. 

 

 
𝑅1 = 550 + 8800 − 6200 = 3150 𝑝𝑖𝑥𝑒𝑙𝑠 Eq. K.1 

  

  

 

R1 

Contour of the stub 

Contour of the tape 
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Appendix L 
Validation of microspheres counting by MATLAB 

The microspheres that are visually present in the microscope images are counted by MATLAB. 
Deviations in the quantification can occur in two ways: particles can be falsely detected and 

particles can be undetected. These deviations had to be minimalised. This was done by visually 

analysing part of the pictures5. To do this structurally, the images were overlapped by a grid, 
see Figure 59.  

 

       
Figure 59 Areas of 4000x4000 pixels in the picture of the tape (left) and substrates (right) were manually 
analysed to validate the method that was used for particle counting. The areas were subdivided by a grid 

in equal squares, so the image could be structurally analysed while zooming in. The white arrow 
indicates the order in which the squares were analysed. 

The following parameters in the MATLAB code were tuned to optimize the performance of this 

method: 

- R_spheres: Range of microsphere radius in the image [px] 

- tolerance_overlap: Tolerated overlap of the detected microspheres [px] 

- sensitivty: Detection sensitivity of microspheres in the fuction 'imfindcircle' 

- nr_bwareaopen: Setting used to remove noise in the Photoshop image with the 

function 'bwareaopen' 

The number of falsely detected particles can be given in the expected number of false particles 

per surface area (pixels2 in the photo), because this number is independent of the number of 
present particles on a surface. The number of falsely detected particles on the tape or on the 
substrate area that is covered by the tape, 𝑛𝑓𝑎𝑙𝑠𝑒𝑙𝑦 𝑑𝑒𝑡𝑒𝑐𝑡𝑒𝑑 𝑡𝑎𝑝𝑒, can be calculated by equation 

L.1. Here, 𝐴𝑎𝑛𝑎𝑙𝑦𝑠𝑒𝑑 is the number of analysed tapes times the surface area of 4000x4000 pixels, 

see Figure 59. The surface area of the tape is 𝐴𝑡𝑎𝑝𝑒 = 𝜋 ⋅ 44002. 

 

𝑛𝑓𝑎𝑙𝑠𝑒𝑙𝑦 𝑑𝑒𝑡𝑒𝑐𝑡𝑒𝑑 𝑡𝑎𝑝𝑒= 𝑛𝑓𝑎𝑙𝑠𝑒𝑙𝑦 𝑑𝑒𝑡𝑒𝑐𝑡𝑒𝑑⋅

𝐴𝑡𝑎𝑝𝑒

𝐴𝑎𝑛𝑎𝑙𝑦𝑠𝑒𝑑

 
Eq. L.1 

 
The number of undetected particles, 𝑛𝑢𝑛𝑑𝑒𝑡𝑒𝑐𝑡𝑒𝑑, depends on the number of present particles, 

and can therefore be given in an average percentage of the present particles in the analysed 
area, 𝑛𝑝𝑟𝑒𝑠𝑒𝑛𝑡, see equation L.2. The number of present particles in the analysed area is 

calculated by equation L.3. 

                                                
5 To do this, ‘Evaluate_Run_define_particle_nr_stubs.m’ and 
‘Evaluate_Run_define_particle_nr_substrates.m’ were used to run ‘Evaluate_define_particle_nr.m’. These 
codes were not included in this report.   

75 detected microspheres on stub1F5 53 detected microspheres on PolcrochA1
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%𝑢𝑛𝑑𝑒𝑡𝑒𝑐𝑡𝑒𝑑 =
𝑛𝑢𝑛𝑑𝑒𝑡𝑒𝑐𝑡𝑒𝑑

𝑛𝑝𝑟𝑒𝑠𝑒𝑛𝑡

⋅ 100 % Eq. L.2 

 
𝑛𝑝𝑟𝑒𝑠𝑒𝑛𝑡 = 𝑛𝑑𝑒𝑡𝑒𝑐𝑡𝑒𝑑 − 𝑛𝑓𝑎𝑙𝑠𝑒𝑙𝑦 𝑑𝑒𝑡𝑒𝑐𝑡𝑒𝑑 + 𝑛𝑢𝑛𝑑𝑒𝑡𝑒𝑐𝑡𝑒𝑑 Eq. L.3 

 
Multiple combinations of parameters were applied and the results were analysed. The 

parameters that resulted in the best performance can be found in the tables below.  

 
Tape 

Settings Picture ndetected nfalsely det. nundetected npresent 

R_spheres = [9 13]; 
tol_overlap_tape = 8; 
sens_tape = 0.975;  
nr_bwareaopen_tape = 40; 

Stub1C4 76 3 4 77 

Stub1D1 71 7 2 66 

Stub1J1 21 1 1 21 

Stub2D1 402 12 49 439 

Stub1C3 28 5 0 23 

Stub1C2 47 (excl. 7 
on fibre) 

7 (excl. 7 
on fibre)  

5 45 

Stub2D2 116 12 26 130 

Total: 761 47 87 801 

Falsely detected particles on tape: 47 ⋅
𝜋⋅44002

7⋅(4000⋅4000)
= 25.5  

Percentage of undetected particles on tape: 
87

801
⋅ 100% = 10.9%  

 

Sewing polyester 

Settings Picture ndetected nfalsely det. nundetected npresent 

R_spheres_textile = [7 13]; 
tol_overlap_textile = 3;  
sens_textile = 0.945; 
nr_bwareaopen_textile = 100; 

PolsewA1_prestub 63 6 10 6 

PolsewB2_prestub 88 8 13   93 

PolsewA1_stubbed 66 11 9 64 

PolsewB2_stubbed 77 9 12  80 

Total: 294 34 44 304 

Falsely detected particles: 34 ⋅
𝜋⋅44002

4⋅(4000⋅4000)
= 32.3  

Percentage of undetected particles beneath tape: 
44

304
⋅ 100% = 14.5% 

 

Crochet polyester 

Settings Picture ndetected nfalsely det. nundetected npresent 

R_spheres_textile = [8 13]; 
tol_overlap_textile = 3;  
sens_textile = 0.97; 
nr_bwareaopen_textile = 40; 

PolcrochA1_prestub 100 6 4 98 

PolcrochA4_prestub 148 7 0 141 

Total: 248 13 4 239 

Falsely detected particles: 13 ⋅
𝜋⋅44002

2⋅(4000⋅4000)
= 24.7   

Percentage of undetected particles beneath tape: 
4

239
⋅ 100% = 1.7% 

 
Extra strong sewing polyester 

Settings Picture ndetected nfalsely det. nundetected npresent 

R_spheres_textile = [8 13]; 
tol_overlap_textile = 3;  
sens_textile = 0.97; 
nr_bwareaopen_textile = 40; 

PolsewstrA2_prestub 81 9 3 75 

PolsewstrA4_prestub 67 3 10 74 

Total: 148 12 13 149 

Falsely detected particles: 12 ⋅
𝜋⋅44002

2⋅(4000⋅4000)
= 22.8  

Percentage of undetected particles beneath tape: 
13

149
⋅ 100% = 8.7% 
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Appendix M 
Datasheet experiment results 
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Appendix N 
Distribution of microspheres over the height of the 

textile substrates before and after stubbing 

Table 7 The number of microspheres that was detected in the different height levels before stubbing 
(blue column) and after stubbing (grey column) is displayed for all sewing polyester samples. 
Furthermore, the used stubbing forces, the names of the sample circles, and the reference heights 
before and after stubbing are displayed. The reference height is the lowest measured height in the 
sample circle, which basically indicates the metal substrate base. The height levels that are given are 
relative to this reference height.  

Stubbing 
force 

Sample 
circle 

Reference 
height 
[µm] 

Height of microspheres in substrate relative to 
reference height [µm] 

0 – 99 
µm 

100 – 
198 µm 

199 – 
298 µm 

299 – 
397 µm 

398 – 
496 µm 

0.1 N PolsewB2 1.79 2.57 0 0 36 11 37 30 110 125 0 8 

0.1 N PolsewB3 1.27 2.08 27 9 112 57 37 98 2 18 0 8 

0.1 N PolsewB4 1.27 1.97 38 1 105 12 0 58 0 78 0 0 

0.2 N PolsewA4 1.28 1.56 8 22 134 121 7 5 0 0 0 0 

0.2 N PolsewA5 1.11 2.04 4 5 58 30 74 105 0 8 0 0 

0.2 N PolsewB1 1.81 1.71 0 0 8 11 15 27 80 64 1 0 

0.5 N PolsewA1 1.28 1.44 20 14 93 47 9 55 0 0 0 0 

0.5 N PolsewA2 1.27 1.18 39 18 76 101 0 2 0 0 0 0 

0.5 N PolsewA3 1.27 1.56 22 30 101 85 7 8 0 1 0 0 

1 N PolsewB5 1.61 1.68 3 1 5 6 116 95 24 26 0 0 

1 N PolsewC2 1.31 1.59 19 13 73 10 7 85 2 6 0 0 

1 N PolsewD1 1.10 1.24 6 3 138 80 2 72 0 0 0 0 

7 N PolsewC3 1.18 1.38 23 36 59 57 7 21 0 3 0 0 

7 N PolsewC4 1.18 1.38 12 2 124 42 2 72 0 1 0 0 

7 N PolsewC5 1.18 1.56 32 9 142 0 0 78 0 5 0 0 

  

Before stubbing 

After stubbing 
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Figure 60 The difference between the number of microparticles after and before stubbing on extra strong 
sewing polyester. The total difference in the number of detected microspheres is displayed in the legend 

per stubbing force. In the sample circles, only the area was analysed that was fully covered by tape 
(n=3). 

 

 
 

 
Figure 61 Mean distribution of microparticles on extra strong sewing polyester substrates over the height 

levels before stubbing (n=3x5). The red lines indicate the standard deviation between the trials.  
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Figure 62 The difference between the number of microparticles after and before stubbing on crochet 
polyester. The total difference in the number of detected microspheres is displayed in the legend per 

stubbing force. In the sample circles, only the area was analysed that was fully covered by tape (n=3). 

 
 

 
 

 
Figure 63 Mean distribution of microparticles on crochet polyester substrates over the height levels 

before stubbing (n=3x5). The red lines indicate the standard deviation between the trials. 
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Appendix O 
Collection efficiency on glass 

 

 
Figure 64 Collection efficiency of microspheres from a glass substrate when sampling with 0.1, 0.2, 0.5, 1 

and 7 N. 

 

 

a.)           b.)   

Figure 65 a.) A glass sample before stubbing with detected microspheres (GlassB2).                            
b.) Stub that was used to collect particles from this sample circle with a stubbing force of 0.2 N 

(stub2B1). The image of the glass sample was mirrored in such a way that the particles detected on the 
tape could be overlaid with the particles on the glass resulting in a match. This image indicates that the 

surfaces of the glass and the tape were not exactly parallel during stubbing. 

 

The microspheres on the glass sample circle were not equally distributed. However, to 
calculate the trace collection efficiency, the mean density of microspheres on the substrate 

before stubbing was used. Because the unequal distribution of microspheres on glass, it was of 
significant influence where the stub was placed on the glass.  

Probably the stub or the support of the glass slide was placed under a slight angle, 

because the results indicate that the tilt angle was similarly oriented every sample (and the glass 
slide itself was replaced every 3 measurements). Because of this tilt, the force was not 

distributed well over the tape, only over a small part of the tape, where the pressure was higher 
than if the force would be neatly distributed over the tape. It seems that one side of the tape 

did not even made contact with glass, because no particles are collected by one side of the tape 
(in multiple trials). 
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